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The Relativity Desktop Client (RDC) provides the functionality for importing document load, image, and
production files, as well as for exporting production sets, saved searches, and folders. You can also use this
utility to import and export object data.

Using the RDC

As a litigation support specialist, you need to export a production of email files for the opposing
counsel in the Salt vs. Pepper case. You created a production set named "Salt vs. Pepper - Email
Production" and ran your production, and now you need to export the production using the RDC.
So, you open the RelativityDesktop Client and log in to your Relativity environment.

by

Username Password

[ )

Continue

You select and open the Salt vs. Pepper case and then click Production Set... on the Export
menu to open the production export options.

('Y Relativity Desktop Client E@g

File | Tools i Options Help

Diocume Import  * |
=3 | Export | Production Set... Mo |

L

Saved Search...
Folder...
Folder and Subfolders...
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Since this production set consists only of email messages, you include your Bates numbering and
email metadata fields in the exported metadata.

(1) Relativity Desktop Client | Export Production Set B
File

Data Source I Destination Files I

— Preductions

Salt vs. Pepper - Email Production ;I

Selected Columns Start Export at Record #
Conversation Index - Begin_bates_1 | 1 :jl
C5R - test et End_bates_1
CSR - test set::Category Email From
CSR - test set:Category Email To
Currency Email BCC
Currency field b Email CC
Custodian - Single ChuicH i | Email Subject
Data Load Date File Name
Data Load Yolume > | Attachment Name (m
Date Sent

Date
Date Created - Date Received
Date Last Modified -

Date Last Printed
DateTime il
Decimal

Delivery Receipt
Deponent / Witness Kit
Doc_Object

Docs_| anguages
Docs_Languages::Langu
Docs_Languages::Perce
Document Extension
Decument Folder Path  —
<[ 3

The case production format requirements you need to comply with include PDF images with an
Opticon data file format and a .csv data file format with Unicode (UTF-8) encoding. On the
Destination Files tab, you select the required format options and also select to copy the files
from the repository to copy the exported emails to your export network directory.
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1} Relativity Desktop Client | Export Production Set

File
Data Source Destination Files I
—Export Location Text and Mative File Names
I\\C.n‘\SESERVN\Case FileshSalt vs. Pepper\Export\Emails | Named after: | Select.... j
[~ Overwrite Files [ Append original filename
—Physical File Export File Path [j ==
¥ Copy Files From Repository ’7(: Use Relative Paths ¥ Export Images
Data File Format: | Opticon -
—Volume Information ——— | Use Absclute Paths I J
. File Type: |PDF -
Prefix: I‘u"OL " Use Prefix I I _I
Start#[1 =] #ofdigits[2 =] [ltes
- ; [ Export Native Files
Max Size (MB): Iﬂ Load File Characters
Cﬂlumn:l. (ASCII:044) v[ [ Metadata
[~ Subdirectory Information Data File Format: ICommaJsepaEned (cav) j
Image Prefi :IIMG Qunte:l" {ASCII:034) vl ] ]
e Data File EnDdeg:IUniccde (UTF-8) j | ? |
Native Prefic[NATIVE Newdine:| (ASCII-010) ||| Export Text Field as Fites
Text Prefix: ITEXT— i ing: ?
Multi-Value: [ (ASCIF059) ] |f TextFile Encoding: |Select.. = ] 2]
Start #: I‘I 3: #ofdigits:l?. 3: Text Pr-BDBdBnDB:I |
) < Nested Value: I (ASCII:052 vl
Max Files:[500 = ' i [¥ Export Multiple Choice Fields as Nested

After selecting your options, you're ready to click Run on the File menu to complete the
production export to be able to send the Salt vs. Pepper emails as PDF images with the required
data files to the opposing counsel.

1.1 RDC menu bar

The RDC menu bar appears above the workspace folder structure. It includes the following menu options:

File:

= Open - switches between different workspaces.

® EXxit - closes the RDC.

= Refresh - updates the folder browser.

Tools - Import:

= |mage File - imports images from a page-level load file.

= Document Load File - imports native files, document metadata, and extracted text from a document-

level load file.

= Production Load File - imports productions from a page-level load file.

Tools - Export:

¥ Relativity
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Production Set - exports production sets.
®m Saved Search - exports from saved searches.
= Folder - exports from a specific folders.
= Folder and Subfolders - exports from a specific folder and its subfolders.
Options:
m Settings - changes the default value for Force Folder Preview and enter a WebService URL.

= Check Connectivity - assists with troubleshooting network and system configuration errors that
occurred while importing and exporting.

Help:
= About - displays the version of the RDC.

= Help - opens the Relativity Desktop Client documentation in your internet browser.

1.2 Workspace folder options

The RDC provides right-click options on folders, which you can use to build the workspace folder structure,
or to import and/or export directly to and from a folder.

Document
3R] Salt vs Peco

Mew Folder...
Import L
Export 3

When you right-click on a workspace or folder, the following menu options display:

= New Folder - create subfolders. In the Add New Folder pop-up, enter a folder name, and then click
OK. The maximum length for the folder name is 255 characters. Since the folder name is a system
field, once you create it, you can't edit it. The new folder is added to the workspace through the RDC.

= Import - import an image file, document load file, or production file into a specific folder. Highlight the
folder, point to Import, and select a file type. If you have metadata, natives and images to load, run
the load file import first, then the image file import. See Importing through the RDC.
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Eile

Tools

Mew Folder...

Import 3
Export

-

Folder...
Folder And Subfolders...

1.3 Starting the RDC

To open the RDC:

1. Double-click on the shortcut installed on your desktop. The Settings dialog box appears when you
open the application for first time.

~,

[ﬁ Relativity Desktop Client | Settings =[] ]

—lFu:urce Faolder Preview Default |
|Enabled -]

{webService URL
|https:a’a’relativit_l,l.ku:ura.u:u:um.-’relativitywebapi

] I Cancel

2. Select or enter settings for the following options:

= Force Folder Preview Default - options to enable or disable this feature. When enabled, the
RDC checks the first 1000 records of the load file after you click Import. It then displays the
number of folders soon to be created. You can use this information to ensure that the load pro-
cess is behaving as expected. If a large number of folders are listed, you can stop the load file,
and verify that the Folder Info field is set correctly. By default, this feature is Enabled.

® WebService URL - enter the URL provided by your system admin. This URL is used to estab-
lish a connection between the RDC and your server. If the URL path is entered incorrectly, you

are unable to connect the RDC to your database.

The WebService URL has the format http or https://<MyServiceName>/RelativityWWebAPI/.
When you display a Relativity page, you see the web service name listed in the address bar on
the browser. For example, if the address bar displayed https://smith.com/Relativity, then your
web service URL would be https://smith.com/ RelativityWWebAPI/. In addition, you can confirm
this URL with your system admin.

3. Click OK. These settings are stored in your machine registry and they are retained when you upgrade
the RDC.
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1.4 Logging on to the RDC

Beginning in Relativity 9.5.292.12, enter your Username and click Continue. Next, enter your Password
and click Login. These are the same credentials you use to log in to Relativity. If the server certificate is
untrusted, you can allow using untrusted certificate or close the RDC. Additionally, if you have difficulty
displaying the login dialog, verify that Relativity is a trusted site in your browser.

Note: Users log in to the Relativity Desktop Client (RDC) with the same provider method as they have
with Relativity. The RDC supports most Relativity authentication providers, such as password, Integrated
Authentication, and OpenlID Connect, by displaying the Relativity login page within the RDC as a dialog
window. The only provider that does not work with the RDC is SAML because the Relativity’s IdP-initiated
SAML does not display the Relativity login page directly.

! Relativity Login - O X I Relativity Login — O X

Username Password

[ismith@example.com sessssssssssssR e

L e

After you log in, the RDC displays a list of workspaces where you have access rights. Use the filter bar to
narrow the list.

Note: By default, Relativity uses a wildcard to filter workspaces in the RDC. For example, enter ELA to
find workspaces named ELAN and Relativity.

Highlight your workspace and click OK to open it in the RDC. The folder structure of your workspace
displays. A new workspace contains only a root folder, while an existing workspace may contain subfolders
that you can display by clicking the plus sign.
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@ Relativity Desktop Client
File  Tools Options Help

Document ;I
R Ea] S alt vs. Pepper

“workspace Loaded - File Transfer Mode: DirE| -

Note: In Relativity Desktop Client, Document is selected by default as the type of object for data import or
export. You can also select other object types, including Relativity Dynamic Objects.

1.5 RDC OAuth2 client

Beginning in Relativity 9.5.292.12, the RDC uses the OAuth 2.0 authorization framework for verifying your
login credentials. The OAuth 2 client offers increased security, because it uses an access token that is valid
for only three days. After the token expires, you must log in to the RDC again. Any jobs currently in progress
fail when the token expires.

On your SQL server, you can extend the token lifetime by editing the [AccessTokenLifetimelnMinutes] field
in the [EDDS].[eddsdbo].[OAuth2Client] view.

For general information about using OAuth2 in Relativity, see OAuth2 clients in the Relativity Admin guide.

1.6 RDC transfer modes

RDC supports the following data transfer modes:

® Direct- uses the file share client. Direct mode provides the fastest transfer speed. Note the following
details:
o Direct mode uses the windows Active Directory account and has direct access to write to the
file repository or the BCPPath. This bypasses the need to go through the web server in order to
ingest the data, saving a significant amount of time.

° There are two direct modes to be aware of:

» Direct Mode for native files - requires read/write access on the workspace file repository
(so that native/image import/export is direct to the share).

» Direct Mode for file metadata - requires Read/Write access on the BCPPath for
metadata. Document metadata passes through the BCPPath, not native files.

= Aspera - uses the Aspera client and requires Aspera credentials. This mode is supported only in
RelativityOne environments and is not available in Relativity Server installations.

= Web - uses the HTTP client. Because of the limitations of the HTTP protocol and varying network
bandwidth, it is the slowest. Note the following details:
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° When you don't have read/write permissions to the BCPPath, Relativity must authenticate via

the web server.

° When you don't have read/write permissions to the workspace file repository, Relativity must
authenticate via the web server.

° When loading through web mode, you can see a drastic performance reduction compared to
Aspera mode and an even greater reduction compared to direct mode. Web mode is the slow-
est method of all, it does, however, work without direct access to the BCPPath.

When you select a Relativity workspace, the RDC queries the workspace and performs tests to determine
the optimal transfer mode. You can see the details of the tests under Options > Check Connectivity:

[+ Relativity Desktop Client | Connectivity Tests - O *

The workspace irfformation was retrieved.

Preparing to test Aspera connectivity.
Testing Aspera upload.

Aspera upload successful.

Testing Aspera download.

Aspera download successful.
Testing Aspera ports.

Aspera connection test is successful.

Preparing to test Direct connectivity.

Testing Direct upload.

Checking default repository access: YW
Created temparary directory in the repositary: W\
Created temporary file in the repositany: \\
Direct upload successful.

Testing Direct download.

Downloaded file from the repositary.

Deleted tempaorary directory in the repositary:
Direct download successful.

Direct connection test is successful.

Preparing to test Web connectivity.
Testing Web upload.
‘Web upload successful.
Testing Web download.
'Web download successful.
Retrieving default repositary drive information:
Success - report follows:
Drive Mame: W\
Free Space: 481,853.805 MB
Used Space: 541,602.155 MB
Total Space: 1,023.456.004 MB
“Free: 47.08 %
%lUsed: 5292 %
'Web connection test is successful.

A
. \FileSharefiles,
“File Sharefiles\ConnectionTest_a732h5%-31f6-dafc-97e543c 21884 7ec T
"FileShare'files\Connection Test_a732h59%b-31f6-4afc-97e543c2 1884 7ec TdmpSE4B tmp
. FileSharefiles\Connection Test_a732b39%-31f6-4afc-07e543c218847ec ™
"FileShare files
W

The RDC then automatically selects the optimal available mode for the transfer job.

Note: You can select more than one mode for the transfer job based on your configuration. The fastest

mode will be displayed first.
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|:;| Relativity Desktop Client
File  Tools Options Help

Document

@ ROC Sample

Workspace Loaded - File Transfer Mode: Aspera

Note: The mode initially selected based on the tests for the workspace may not be used in the actual
transfer, for example due to a connection problem. If a problem occurs, RDC falls back to a different mode

or displays an error.

The transfer mode also displays on the RDC progress window.

Desktop Client Guide 12
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¥ Import Load File Progress ... — O >

a8
End upload 13367a1b-8333-45%-a2b1-51cbb133520¢’ file. (778ms) [line 33]

85 of 686 processed

Summary | Emors I Progress I Wamings I Report I

Start Time: 2:53:08 PM
Duration: 00:00:14

Time Left to Completiom: 00:01:40

Total Records: &8¢

Total Processed: 28

Total Processed w/Warnings: 0O
Total Processed w/Errors: 0

Lverage file transfer rate: 777.20 EB/sec
Current batch size: 1,000

File Transfer Mode: Aspera, Metadata: Pending

You can also force the RDC to use a specific mode.

1.6.0.1 Transfer Mode Statuses
The following statuses may display during the transfer:

= Pending - displays when transfer mode is not yet determined.

= Disabled - displays when File Repository Preference is set to not copy files.

1.6.1 Direct mode

Direct mode provides faster performance, but it requires a connection to the network hosting the data, as
well as specific Windows group permissions. Direct mode has direct access to write to the file repository,
which bypasses the need to go through the web server in order to ingest the data, saving a significant
amount of time.

1.6.1.1 Setup
The following conditions must be met in order to load data using direct mode:

tH Relativity Desktop Client Guide 1



= The Active Directory account running the load must have direct access to the Relativity File Repos-
itory and BCPPath folder.

® The loaded data must be located on the Relativity system network/domain.

= The computer running the Relativity Desktop Client must be located on the Relativity system net-
work/domain.

= The group of users responsible for uploading documents through the Win Relativity component
(Relativity Upload Users) must have Full Control in the Document Repository Share. This allows
members of this group to import and export in Direct mode. Non-members can only import and export
in Web mode. the Pre-installation guide.

Note: The option to change the default repository path when importing through the RDC is unavailable
when Aspera mode is enabled.

= The option to change the default repository path when importing through the RDC is unavailable
when Aspera mode is enabled.

@Relativity Desktop Client Guide )



2 Using the RDC installer

To use the Relativity Desktop Client (RDC), you must download a copy of the RDC installer and then install
it.

Note: To ensure a safe and stable product experience, effective with the Server 2024 release, we only
support the version of RDC that was shipped with the current release as well as one release back. For
example, Server 2024 RDC will work with both Server 2023 and Server 2024 but not with any releases
prior to Server 2023.

2.1 Software requirements

The RDC installer checks for the software prerequisites. If you're missing any of the prerequisites, your
computer must have Internet access, so the RDC installer can fetch the required software. If your computer
doesn't have Internet access, the RDC installer can't fetch the required software, so the installation fails.

Note: You do not need Internet access to install the RDC if your computer has all the prerequisites.

The RDC requires the following software:

® Microsoft NET 4.6.2 or above

® Redistributables listed in the following table:

Operating System VC++2010 (x86) VC++2010 (x64) VC++2017 (x86) VC++2017 (x64)
32-bit v v

64-bit v v v v

Note: If you need to perform an offline installation, you must manually install the software required for the
RDC listed in this section.

2.2 Downloading the RDC installer

To use RDC, you must first download a single executable file that runs on both 32-bit and 64-bit operating
systems.

To download the RDC installer file:

1. Open your workspace in Relativity.

2. Selectthe Workspace Admin tab.
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3. Click Workspace Details to display the Relativity Utilities Console.
ot [ o [ o [ v o

RELATIVITY UTILITIES
System Settings

Workspace Information

Name: Diata Testing SQL Full Text Language: English
Manage Workspace Permissions
. . Relat " ) -
Client Name: RelativityOne Client Client Number: 1 Manage System Keyboard Shortcuts
Matter Name: RelativityOne Matter Matter Number: EBilling View Another User's Personal ftems
Status: Active Production Restrictions:
_ Relativity Downloads
Workspace Admin Group:
Viewer Installation Kit
) Rclalivity Desktop Client
Resource Information
Resource Pool: RelativityOne Fool Database Location: clus01412310W01 sgl-

001.r1.ki i ctus01412810W01
Defauli File Repository: \files\T010\Filest yuU1.rl. kcura.comictus

id: i
Data Grid File Repository: EEbi Do Cr

Default Cache Location: Default Cache Download Handler URL: Relativity Distributed

Location
Other
Keywords:
Notes:
Record History
Created: Wendt, Eric - 121272018 Last Modified: Service Account, Relativity -
3:30:52 PM GMT 1211272018 3:31:20 PM GMT

4. Click Relativity Desktop Client under the Relativity Downloads selection. Relativity downloads the
Relativity.Desktop.Client.Setup.exe.

5. Complete the steps for installing the RDC. See Installing the RDC for more information.

2.3 Installing the RDC

After downloading the installer file, you can proceed with installing it.
To install the RDC:

1. Complete the steps to download the Relativity.Desktop.Client.Setup.exe in Downloading the RDC

installer.
2. Double-click on Relativity.Desktop.Client.Setup.exe to launch the installer.

3. Foruse with RelativityOne, select checkbox called This application will be used with Relativ-
ityOne.

I_'FIJRelatIV|ty Desktop Client Guide 16



@ Relativity Desktop Client Setup — *

Relativity Desktop Client

Fublisher: Relativity ODA LLC

This application will be used with RelativityOne.

Options || anstall || Close

4. Foruse with Relativity Server, clear checkbox called This application will be used with Relativ-

ityOne.
@ Relativity Desktop Client Setup — >

Relativity Desktop Client

Publisher: Relativity ODA LLC

[1 This application will be used with RelativityOne.

Options || anstall || Close

Y Re[ativity Desktop Client Guide
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5. If you want to specify an installation location, complete these steps:
a. Click Options.
@ Relativity Desktop Client Setup — X

Relativity Desktop Client

Fublisher: Relativity ODA LLC

Setup Options

Install location:

| | Browse

(0.4 | | Cancel

b. Click Browse to select a directory where you want the RDC installed. The default installation

directories include:
32-bit—C:\Program Files (x86)\kCura Corporation\Relativity Desktop Client

64-bit—C:\Program Files\kCura Corporation\Relativity Desktop Client
c. Click OK.

The RDC installer checks for the software prerequisites. If you're missing any of the prerequisites,
your computer must have Internet access, so the RDC installer can fetch the required software. If
your computer doesn't have Internet access, the RDC installer can't fetch the required software, so
the installation fails.

Note: You don't need Internet access to install the RDC if your computer has all the prerequisites.

6. Click Install on the RDC setup wizard to start the installation.

7. Click Close when the installation has completed.

Note: The executable for the RDC has been renamed to Relativity.Desktop.Client.exe. If you
use an antivirus scan in your environment, you may want to update your settings to accommodate
the renamed RDC executable.

Your desktop now displays a shortcut icon for the RDC, which you can click to launch it.
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Client

2.4 Installing the RDC in quiet mode

You can use quiet mode to run unattended RDC installations through the command line. Open a command
prompt and enter the following:

Relativity.Desktop.Client.exe /q /log InstallLog.txt /INSTALLFOLDER "<RDC
Installation Directory>"

This command takes the following parameters.

Parameter Description
/INSTALLFOLDER Specifies a custom installation path. This parameter is optional.

Used to create a log file. Specify a file name and path for the log file. This parameter is
optional.

/q Runs the installation in quiet mode.

/log

2.5 Repairing or removing RDC installation

You can also run the installer to repair, or remove an existing installation of the RDC. Run the installer on a
machine where the application is installed. Select one of the following options:

®m Repair—attempts to fix errors in the most recent installation.

= Uninstall—removes the RDC from your machine.
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3 Importing through the RDC

You can import document load files, as well as image and production files, through the Relativity Desktop
Client (RDC). You need to install the RDC on your computer before you can perform an import.

Note: You must be logged in to a Relativity environment in order to successfully import files.

You may also use the Windows Command Line to import documents into Relativity. With the Windows
Command Line you can automate document importing along with other parts of your processing and
integration process. See the Command Line Import guide.

3.1 Importing RDC Permissions

The following permissions are required to use the importing feature in Relativity Desktop Client:

Object Security Tab Visibility Admin Operations

® Document: View,

Add, Edit = Documents = Allow Import

Note: Changing root folder permissions during import is not a supported workflow.

3.2 Importing multiple load files simultaneously

You can safely import multiple load files into the same workspace simultaneously. For best results, use
multiple machines and one active instance of the RDC per machine.

Note: We recommend limiting this to four concurrent imports at a time into one workspace.

3.3 Handling errors

Relativity skips any records with errors that it encounters during the load process. It warns you about any
errors that were encountered after all the correct records have loaded.

Errors have ocosred. Export error files?

I il =

When you click OK in the error warning box, Relativity creates a new document-level load file with only the
erroneous records. This file lists all the errors that occurred during the load process. You are prompted to
save these records to prevent any loss of data. Choose a path to save your error file and click OK.

@ Relat|V|ty Desktop Client Guide 20
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After you have saved your error file, you can make any necessary corrections to those records, and then
perform an Append Load. A record of these errors is also available in the Errors tab, referencing the
workspace name and Artifact ID.

3.4 Saving import settings

You can save the settings used to import a load file. This option is helpful if you frequently work with your
own internal processing tools or with the same processing vendor. To save your import settings, point to the
File menu, and then click Save Import Settings. Choose a location for the document load file (.kwe).

Note: .kwe stands for kCura Win Edds.

The settings for the selected destination path and for copying files to a repository aren't saved in the .kwe
file.

When you have an identically formatted load file, you can use your saved .kwe. In the RDC, open the .kwe
file, and select the file being loaded.

You can also update the path in the .kwe file. The following illustration displays the text of a .kwe file. The
fourth line contains an absolute path to the document-level load file to be loaded. Update this section to
point to your new load file. After you have updated your .kwe file, select File and Load Import Settings.
Test for any errors, and then load the file.

mpklmﬂ - ¥

tSOAP-ENV :Envelops xmlns:xsi="http: - vew w3, org'f'EI]EIl/IHI.Echeu-mstanr—'
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tExtractFul lTextFroafativaFile:falssdExtractFul lTextFromlativaFs le:
tExtractMDSHashFromliativelFilerfalsed /ExtractiD5HashFromHativeF1le?
tFecordDeliniter»20< FecordDel ini tex >
(fuoctelDelimiter»254 < Tuoteleliniter:
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3.4.1 Saving a field map

You can save the field mapping used to import a load file. The field map is exported as a CSV file that saves
the mapping of the Relativity fields to those in the dat file being imported. You can save or view your field
map from the Field Map tab or from the File menu in the Import Document Load File window. To save your

field map:

1.
window opens.

Click Export to CSV.

From the Import Document Load File window, click View/Save Field Map. The Selected Field Map

Destination Field

Cortral Mumber [ldentifier]

| Source File Column
Author (4)

Cortral Mumber (2)

Conwversation

Conversation (5)

Custodian - Single Choice

Custodian (7)

Date Created

Date Created (5)

Date Last Modified

Date Last Modified (3)

Date Received

Date Received (10)

Date Sent

Date Sert (11}

Document Exdension

Document Extension (12)

Email BCC

Email BCC (13}

Note: When importing a CSV file with currencies, the formatted column must be Number.

3.5 Viewing audit information for an import

After you import your file, the RDC records and audits this instance in the History tab. Click Import to display
the settings used for the import. To view the transfer rate of the load file, add the Execution Time field to the
view, if necessary.

3.6 Load file specifications

Using load files, Relativity can load the following types of files. The sections below detail the load file
requirements for the respective file types.

®m Metadata, extracted text, and native files
® |mage and extracted text files

® Processed data
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3.6.1 Supported file types

Relativity accepts only the following load file types:
m  dat
m _csv

B ixt

3.6.2 Metadata, extracted text, and native files

Relativity uses a flat, document-level load file to load metadata, document level extracted text, and natives
files. Each line should represent one document.

3.6.2.1 Encoding

The Relativity Desktop Client (RDC) attempts to determine the encoding of a file, by default, when a load file
is first selected. To do this, the RDC checks the byte order mark at the beginning of the file. If there is no
byte order mark, it cannot determine the encoding type. The types of byte order marks include:

= Unicode (UTF16)
= Big-Endian Unicode
= UTF8

Everything else is considered undetectable by the RDC and uses the default encoding chosen for the load
file or stand-alone extracted text file.

A variety of load file encoding options are supported, including:

= Western European (Windows)

= Unicode

= Unicode (Big-Endian)

® Unicode (UTF-7)

= Unicode (UTF-8)

m  Qther options, based on your SQL sever

3.6.2.2 Header row

Relativity doesn't require load file header rows. However, they are strongly recommended to ensure
accuracy.

The field names in your header don't need to match the field names in your workspace.

3.6.2.3 Fields

Relativity doesn't require any specific load file field order. You can create any number of workspace fields to
store metadata or coding. During the load process, you can match your load file fields to the fields in your
workspace.

The identifier field is required for each load.

When loading new records, this is your workspace identifier.
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When performing an overlay, you can use the workspace identifier or select another field as the identifier.
This is useful when overlaying production data. For example, you could use the Bates number field rather
than the document identifier in the workspace.

All fields except Identifier are optional; however, you may find some of the following system fields beneficial.

1. ldentifier—the unique identifier of the record

2. Group ldentifier—the identifier of a document’s family group
= The group identifier repeats for all records in the group.

m Usually, this is the document identifier of the group’s parent document. For example:
o [f an email with the document identifier of AS00001 has several attachments, the email
and its attachments have a group identifier of AS00001.

= |f a group identifier for a record is not set, the document identifier populates the group identifier
field in the case. This effectively creates a “group” of one document.

3. MD5 Hash—the duplicate hash value of the record
® You can enter any type of hash value (and rename the field in your case).
= |f documents share the same hash value, Relativity identifies the documents as a duplicate
group.

® |f a hash field for a record is not set, the document identifier populates the hash field in the
case. This effectively creates a “group” of one document.

4. Extracted Text—The text of the document. Either the OCR or Full Text.

® The extracted text appears in the viewer and is added to search indexes. This field can contain
either:

° The actual OCR or Full Text

° The path to a document level text file containing the OCR or Full Text. The path to a doc-
ument level text file containing the OCR or Full Text. Both relative and absolute paths
are supported (use Windows-style formatting containing backslashes "\").

5. Native File Path—the path to any native files you'd like to load.
= Both relative and absolute paths are supported.

6. Folder Info—builds the folder browser structure for the documents.
® This field is backslash “\” delimited.

= |f not set, the documents load to the root of the case.

® Each entry between backslashes is a folder in the Relativity folder browser.
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® Each backslash indicates a new subfolder in the browser.

Note: For example, if the load file contained the following entry in the folder info field:
“Slinger, Ryan\Email\deleted_items”
Relativity would build the following folder structure:

E||_| Slinger, Ryan
. E|| | Email
.[=] deleted_jtems

Each document with the above entry would be stored in the “deleted_items” folder.

7. Relativity Native Time Zone Offset—Relativity’s native viewer technology displays all email header
dates and times in GMT. This numeric field offsets how email header dates and times appear in the
viewer.

® |f the value in this field is blank, or 0, for a document, then the email header date and time
appears in GMT.

® You can enter a whole number in this field — positive or negative — to offset the time from GMT
to the local time zone of the document.
° For example, if the document was collected from US CDT time, enter “-5” in the field,
because the CDT offset from GMT is -5.

= This ONLY applies when viewing email header dates and times in the Relativity Native File
Viewer. Your metadata fields display as imported.

3.6.2.4 Accepted date formats

Relativity accepts date and time as one field. For example, Date Sent and Time Sent should be one field. If
date sent and time sent ship separately, you must create a new field for time. You can format date fields to
accept the date without the time, but not the time without the date. Dates can't have a zero value. Format
dates in a standard date format such as “6/30/2017 1:23 PM” or “6/30/2017 13:23”.

Note: When you import data using a load file with a date format that differs from the format used on your
local machine, Relativity follows the locale setting of your local machine to determine how it interprets
what is in the load file.

The table below lists the date formats recognized by the Relativity Desktop Client and the Import API. It
contains both valid and invalid date formats:

Entry in Load File ~OPJeCt Definition
Type
12/31/9999
12/31/9999 0:00
Monday January 4 1/4/2018
2018 0:00
05/28/2016 7:11  05/28/2016
AM 7:11 AM
5 08:40 PM 6/30/2019  The current date will be entered if the date is missing. For this example,
17:08 assume the import was done on 6/30/2019.
17:08:33 6/30/2019  The current date will be entered if the date is missing. For this example,
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Entry in Load File

17:08
5:08 PM
14-Apr
9-Apr
14-Mar
1-Mar
22-Feb

20180420

20180420 2:22:00
AM

4/9/2018 16:13
4/9/2018 8:49
9-Apr-18

Apr. 9, 18
4.9.2018
4.9.18
4/9/2018

4:9:2018

Wednesday, 09
April 2018

12-31-1753

2014-11-
28T17:45:39.744-
08:00

Object
Type

17:08 assume the import was done on 6/30/2019.
6/30/2019  The current date will be entered if the date is missing. For this example,
17:08 assume the import was done on 6/30/2019.
6/30/2019  The current date will be entered if the date is missing. For this example,
17:08 assume the import was done on 6/30/2019.
4/14/2019
0:00
4/9/2019
0:00
3/14/2019
0:00
3/1/2019
0:00
2/22/2019
0:00
4/20/2018
0:00
4/20/2018
0:00
4/9/2018
16:13
4/9/2018
8:49
4/9/2018
0:00
4/9/2018
0:00
4/9/2018
0:00
4/9/2018
0:00
4/9/2018
0:00
4/9/2018
0:00
4/9/2018
0:00
12/31/1753
12:00 AM

Definition

The current year will be entered if the year is missing.
The current year will be entered if the year is missing.
The current year will be entered if the year is missing.
The current year will be entered if the year is missing.

The current year will be entered if the year is missing.

11/28/2014
0:00
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Entry in Load File ~COPJect Definition

Type
4/9/18 13:30 PM Results in an error
2018-044-09 Results in an error
4/9/2018 10:22:00 .
Results in an error
a.m.
00/00/0000 Results in an error unless the CreateErrorForinvalidDate value is set to

false in the Relativity.Desktop.Client.exe.config file.

In addition, Relativity takes into account the regional settings of the SQL Server where the database
resides. For example, you may have an SQL Server residing in the UK that uses the date format
DD/MM/YYYY, such as 4/9/2011. When you access a workspace on a PC with UK regional settings, the
date appears as 4/9/2011. When you access the same workspace on a PC with US regional settings, the
date appears as 9/4/2011.

3.6.2.5 Delimiters
During import, you can designate which delimiters are used in your load file. You can select each delimiter
from the ASCII characters, 001 — 255.

The delimiter characters have the following functions:

® Column—separates load file columns
® Quote—marks the beginning and end of each load file field (also known as a text qualifier)
= Newline—marks the end of a line in any extracted or long text field

= Multi-value—separates distinct values in a column. This delimiter is only used when importing into a
Relativity multi-choice field.

= Nested-values—denotes the hierarchy of a choice. This delimiter is only used when importing into a
Relativity multi-choice field.

Note: For example, say a load file contained the following entry, and was being imported into a
multi-choice field: “Hot\Really Hot\Super Hot; Look at Later”
With the multi-value delimiter set as “;” and the nested value delimiter set as “\"”, the choices would

appear in Relativity as:
Hot
Really Hot
Super Hot
|:| en fuego
[WEs]
[C] 2 A} (Med Expert)
Look at Later

3.6.2.6 Default delimiters
If you generate your own load files, you may choose to use Relativity’s defaults:
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= Column—Unicode 020 (ASCII 020 in the application)

= Quote—Unicode 254 (ASCII 254 in the application)

® Newline—Unicode 174 (ASCIl 174 in the application)

= Multi-Value—Unicode 059 (ASCII 059 in the application)

= Nested Values—Unicode 092 (ASCII 092 in the application)

3.6.3 Image and extracted text files

Forimage imports, Relativity requires Opticon load files with ANSI/Western European encoding. This .opt
text file references the Control ID on a page level. The first page should match up to any data you intend to
load. You can use this same process for importing page-level extracted text.

Relativity does not support Unicode .opt files for image imports. When you have a Unicode .opt file, you
must resave this file in ANSI/Western European encoding.

You must convert images in unsupported formats using a third-party conversion tool before Relativity can
successfully upload them.

3.6.3.1 Image file formats
Relativity accepts only the following file types for image loads:

= Single page, Group IV TIFs (1 bit, B&W)
® Single page JPGs
Multi page TIFs and PDFs can be imported into the system, but you must load them as native files.

3.6.3.2 Load file format
The Opticon load file is a page level load file, with each line representing one image.

Below is a sample:

REL00001,RELO1,D:\IMAGES\001\RELOO001.TIF,Y,,,3
REL00002,REL01,D:\IMAGES\001\RELO0002.TIF,,,,
RELO0003,REL01,D:\IMAGES\001\RELO0003.TIF,,,,
REL00004,REL01,D:\IMAGES\001\RELOO004.TIF,Y,,,2
RELO0005,REL01,D:\IMAGES\001\RELO0005.TIF,,,,

The fields are, from left to right:
= Fijeld One — (REL0O0001) — the page identifier
= Fjeld Two — (RELO1) — the volume identifier is not required.
= Field Three — (D:\IMAGES\001\RELOOOO1.TIF) — a path to the image to be loaded
= Field Four—(Y) — Document marker — a “Y” indicates the start of a unique document.
= Fjeld Five — (blank) — can be used to indicate folder
= Field Six — (blank) — can be used to indicate box

= Field Seven — (3) — often used to store page count, but unused in Relativity
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3.6.3.3 Importing extracted text during an image load

You can also import extracted text during the image import process by setting an option in the Relativity
Desktop Client. For more information about importing extracted text during an image load, see Importing an
image file in the Relativity Desktop Client Guide.

No changes are needed in the Opticon load file. If the aforementioned setting is active, Relativity looks for
page level txt files named identical to their corresponding TIFs. For example:

&% RELO0OO1. TIF
| RELOQOOY et
& RELO0002. TIF
,_, RELOOOOZ £t
|5 RELOOOOS.TIF
| RELOOOOS. et
& RELO00O4. TIF
| RELOOOO4 txt
| &% RELO0O0OS. TIF
| RELOOOOS ot

3.6.4 Processed data

Some data originates from client files and needs processing to extract the metadata. The following table
shows the delimiters that your internal processing software must use to present data as fields.

Value Character ASCIl Number
Column 1 020
Quote b 254
Newline ® 174
Multi-Value ; 059
Nested Value \ 092

You can provide this list to your vendor to help communicate the required delivery format for load files. The
fielded data should be delivered as delimited files with column or field names located in the first line.

pContrel NusberpEEGCArtachmenchEl@bAccachment Parent IDREEBbAuchorbElBECacegorizacicnp@l-Cacegorizacion F
MYEIIS_DUDUGDlh-:hn_b‘h‘h‘m-h‘h-:ﬂ1CBWITMHF232351161*!6!‘&79E3DODGE
PAMEYERS 0000003 I b S b R - S b b R | R - e R . Pecersonp @R 010002 TOABSZFCISFTTAS164TSE
PAMEYERS 0000004 bIEREy b ER R - R b b R R s T Calzap R0 LC D0 TDACAEF L ADEACTEODS TCARS ]
PAMEYERS 0000005 N b G b - N | i | R | - - b N deal 535246.1 RElianc HLF dma 7634/763cpEED
BAMEYERS 000000 6 RN (RN b R - R 1 (Y O . 6 00 (R Hon Responsive: pENpHEEInfs an sese cuts for 05
PAMEYERS 0000007 b b S |- S b W b R O . & SR DD on Responsive; pEMIPLEIDInfo on some cuts for 05
PAMEVERS 0000002 b b R - R R R . 44 R PR e apon s ive s P ERI P ERIRTAS 228 7pERRROLCE002TES e,ml
PAMEYERS 000000 0 RN b R - - N |- i | R |y - R b R HEW PAC HunberspEENR01C9D02 TEI 966CFDOEBECHS
hﬁHE‘fEF.S_III'IIDIZI:-Lﬂhn:hmb‘b‘hmhmb‘b‘hnm:ea co Heep in mindp@ER01C9D027B29647CD03
PAMEYERS 0000011 IR b R - R o - b R O . T e - LR Re sponsive s pERID b EREICAcconpliskrents and Goals 20
RAMEYERS 0000083 i b A - - W R 0 . T o R R e spon sive s pEREILCERCLY Cogen cut for HE 1MREREELC
PAMEYERS 0000013 N I - - - O . 3 ER tion Responsive: pEENpRERIRCur on TAG 2304 1pEEERR01C
hmﬁnﬂ_ﬂﬂﬂﬂﬁl!hn}hnmb-ﬁhn}ﬂ.B?]:'n}hm:fan Responsive;: bEGHEEETAC 258830 ERER:01C9D02782
bLﬂYERS_Eﬂﬁﬂﬂlﬁhmhmmt“bmﬂ.'-'Ehmhmﬂ':m Responsive; G EEISTAG 262350 EEIH01C30027B2|
PAMEYERS 00000 & R b S b R o s b R b R s - B R Frontier Unit Cutage for 07/21/01pEEER01CSL
PAMEYERS 0000017 NN b R - - - b i | R - - - s Tag $27652 ¢ 276SEpEEIR01CHD0ITEICOBCESAED]
BAMEYERS 00000185 RN IR b g - R | R b R - O - R o s Ly COGEN for 07/21/01pEEEE01CSD027B2C090DEE
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3.7 Importing document metadata, files, and extracted text

You can use a document-level load file to import document metadata, native files, and extracted text. For
large data sets, consider breaking the load file into smaller document counts. Use multiple computers and
instances to load the individual load files. It may be helpful to break up the types of information into distinct
subgroups; such as load metadata, natives, text, and images. Loading data in smaller amounts can assist
with quality assurance. We recommend having no more than four concurrent RDC imports running on the
same server or in the same workspace.

In addition, you may see warning or errors during an import under the following conditions:

= Native file with 0 KB - The RDC imports native files with the size of 0 KB. In the RDC, the Warnings
tab displays a message indicating that the file is empty and only metadata has been loaded for the
record. In the viewer, users see extracted text when it exists for the file. If the file has no extracted
text, users see a blank placeholder, and no image or viewer options are available. See Configuring
the RDC on page 97.

= | ong file path names - If the load file contains a field used to set the folder path on the folders
browser, and the field is longer than 255 characters for a document, the RDC displays an error mes-
sage for that document on the Errors tab. The RDC doesn't import the document into Relativity. The
RDC continues to import any other documents in the load file with fields shorter than 255 characters.

3.7.1 Importing RDC Permissions

The following permissions are required to use the importing feature in Relativity Desktop Client:

Object Security Tab Visibility Admin Operations

® Document: View,

Add, Edit = Documents = Allow Import

Note: You must also be part of a group that has access to the parent folder of the workspace or you will
receive an error when selecting that workspace in the RDC.

3.7.2 Importing documents
Use the following steps to import documents:

1. Open the RDC and select a workspace.

2. Onthe Tools menu, point to Import and then click Document Load File. (In the RDC browser, you
can right-click on a specific folder, point to Import and click Load File.) The Load File tab in the
Import Document Load File window appears.

r ‘
| Relativity Desktop Client E=NEGR

Eile | Tools i Opticns Help

Docume Import Image Load File... Crl+1 LI

=-3 Export ¥ Document Load File... Ctrl+L
Production Load File... Ctrl+P

tH Relativity Desktop Client Guide .



3. (Optional) To use settings in from an existing import file, use these steps:
a. On the Import Document Load File dialog, click the File menu, and select Load Import Set-
tings.
b. Browse for your load field map file (.kwe) in the Open Saved Field Map dialog, and then click
Open.

c. Click OK on the kCura.EDDS.WinForm dialog. Click Open on Choose Load File dialog. Set-
tings from the file are used to populate fields in the Load File and Field Map tabs. (You can also
modify any settings on these tabs as necessary.)

d. Continue with step 7.

4. CIick;| to browse for a document load file on the Load File tab. Set the other options as necessary.
On the Load File tab, set the following options to indicate how your load file is configured:

= First line contains column names — select this option if your load file has a header.

4 Relativity Desktop Client | Impart Document Load File

File Import
Impaort Destination
“Salt vs. Pepper',

Load File | Field Map |

Load File
’]C:"-.Llsers"-rnlinderrnan"-.Documents"-.l\"lisc Docs'RCA Info*Loading ExerciseLoading Exercize"Basic Load"Basic Data Load_export dat |
I¥ First line contains column names [FRETnmEzEiEE
- - Author (2)
Start Line [0 = ey
File Encoding CC(4
Control Number (1)
IWestaﬂ European f'MnchI | ? | Custodian (5}
Date Received (7)
—Characters Date Sert {5}
Column Email Subject (8)
BExtracted Text (20)
[neasci-o2n) -] FILE_PATH 21)
Filename (S)
Quote Filetype (10)
Folder Path (12)
|b (ASCI1:254) =l From (11)
. Group Identifier {13)
Newline lssue (14)
B (ASCII174) - lssue? (15)
I _I Parert Date (16)
Multi-Val Source File (15)
e Subject (17)
|: {ASCI1:059) LI Ta (18)
MNested Value
|\ (AsCii:082) |

m Start Line - select the line number in the load file where you want the import process to begin.
The default value is 0, which results in loading the entire file.

= File Encoding - select an encoding for the document load file. (Consult your processing
vendor or department to determine the correct encoding option, if necessary.) If your file con-
tains a language other than English, choose a Unicode option. Click
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L]

for additional options or click

7

for additional information about encoding.

P

a5l Pick Encoding

[SIE]EE]

Arabic [B64]

Arabic [A5M0O 708)

Arabic ([DOS)

Arabic [150]

Arabic [Mac]

Arabic fwindows]

Baltic (D0O5)

Baltic [150]

B altic Mfindows]

Central European [DOS])
Central European [150]
Central Ewropean [Mac]
Central European Mwindows]
Chineze Simplified [ELIC]
Chineze Simplified [GB18030)

Chineze Simplified [GB2312)
Ok

[a]

Canicel

-

|

Review the following information about how the encoding of load files is handled:

[e]

Relativity uses auto-detection to determine the encoding of your text files. If it finds a dif-

ferent file type in your text files, it changes to the appropriate method.

Relativity immediately applies any changes that you make to the encoding of a load file,

and displays these changes in the column header preview.

of the extracted text files.

Relativity provides you with the ability to audit the encoding of a load file.

Relativity includes the functionality for previewing the import file as well as the encoding

= File Column Headers - Relativity automatically updates this section of the Load File tab when
you select the file encoding. This section may display the following message before you select
an encoding for the load file.

“File Column Headers

The encoding of the zelected load file could not be detected. Pleaze select the load file's encoding.

After you select the encoding, this section displays the fields in the load file. The column
headers in the file display as vertical list. The fields display in alphanumeric order. The numeric
value in parentheses indicates the position of the field within the file. For example, the control
number is the first column in this illustration, while the Application Name is second.
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—File Colurmn Headers ———

Application Mame [£]
Attachment [3]
Attachment Parent 1D [4]
Author [3)

BLCLC [E]

CC[7)

Contral Murmber [1]
Corverzation [2]
Corversation Family [3)
Corwerzation (D [10]
Custodian [17]

Date Created [12]
Date Last Modified [13]
Date Received [14)
Date Sent [15]

Email Subject [15]
Extracted Text [17]

Since the load file is parsed based on the delimiter set, you may need to check delimiters used
in the load file if the column headers are not lined up correctly. Determine the delimiters used in
the file, and then select them in the Character section of this tab.

= Characters - select the delimiters used by your load file:
° Column delimiter - select the character used to separate columns.

° Quote - select the character used as the text qualifier.

° Newline - select the character used to indicate the end of a line in any extracted text or
long text field.

° Multi-value delimiter - select the character used to separate choices within a field.

° Nested value - select the character used to separate the different levels of a multi-
choice hierarchy.
For example, you might import a field with following values: “Hot\Really Hot\Super Hot;
Look at Later”. Using a semi-colon (;) as a multi-value delimiter, and a backslash (\) as a
nested value delimiter, Relativity displays the choices as illustrated below:

¥|Hot
Really Hot
Super Hot
|:| en fuego
I =

] 2FA}F (Med Expert)

¥| Look at Later

5. Click the Field Map tab. To automatically map fields, click Auto Map Fields below the lists of fields.
The fields from the load file are mapped to any existing fields of the same name in the workspace.
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Load File Field Map

Weorkspace Fields Load File Fields
| Fitter | Fiter | Fiter | Fiker

Entity Recipient ~ Author s Author (4) ~

Entity To Control Number [ldentifie Control Number (2)

ETHND Conversation Conversation (5)

Excel Hidden Columns 33 | Custodian Custodian (7) 33 |

Excel Hidden Rows Email BCC Email BCC (13)

Excel Hidden Warksheel Email CC Email CC (14)

Exccel Pivot Tables - | Email From | ¢ Email From (15) e |

Extracted Text Size in Kl Email Subject Email Subject (16)

Family Group . | Email To | 4 ||Email To (17) . |

File Extension Extracted Text Extracted Text (18)

File Type MDE Hash MO5 Hash (23)

Has Hidden Data €€ | Mumber of Attachments number of attachments (; €€ |

Has OCR Text Parent Document 10 Parent Document 10 (25)

Image Taken Date/Time Title Title (27)

Imaging Set File Name Filename (19)

Imanina Warnina R File Siza N File=iza M i

< > < > < > < >

Only fields matched in the center columns are loaded into the workspace. Other fields in the
Workspace Fields and Load File Fields lists are ignored. You must always match the identifier field for
the load file.

Consider the following when auto-mapping fields:

®m Case isn't taken into account for the mapping. For example, a field named "email" in the load
file would map to a field named "Email" in the workspace.

® Spacing is taken into account. For example, in a two-word field name, if there is one space
between words in the workspace field, and two spaces between words in the load file field, the
fields will not be mapped.

= Characters are mapped only to themselves. For example, an underscore is only mapped to
another underscore, not to a space.

Note: You can also manually map fields in the load file to existing fields in the workspace.

To manually map fields, highlight a field from the Workspace Fields list and click the right arrow to
move the field into the center column. Then, highlight the corresponding field in the Load File Fields
list and click the left arrow to move the field into the center column. You can move all fields in a list
into a new column by clicking the double arrow buttons. Use the up and down arrow buttons to
reorder the fields.

Review these additional guidelines when you map fields for a workspace and load file:

m Before importing relational fields, review the Import Behavior option on the New or Edit Field
form. You can use this option to determine how blank values are handled in relational fields.

= |f you are importing a field that contains more than 200 choices, you will see these choices
automatically displayed in a Popup Picker. You will see an error if duplicate choices exist for
the field.

Overwrite and Overlay identifiers:

In the Overwrite section, select one of these options to indicate the type of load:
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= Append Only - loads only new records.

= Qverlay Only - updates existing records only. You must include an Overlay Identifier in an
overlay load. This field acts as a link indicating to Relativity where to import the data.

= Append/Overlay - adds new records and overlays data on existing records

If you are performing an overlay or append/overlay, select an Overlay Identifier to specify the field
that links your overlay load file to the workspace.

Note: The fields in the drop-down menu are fixed-length fields with a manually-applied SQL index.
This is NOT the same as adding the field to the full-text index. Contact your SQL database
administrator to apply an index to a field.

Multi-Select Field Overlay Behavior:

The following fields are only available if you select the Append / Overlay or Overlay only Overwrite
option:

= Merge Values - merges all values for multi-choice and multi-object fields in the load file with
corresponding multi-choice and multi-option fields in the workspace. The fields are merged
regardless of the overlay behavior settings in the environment.

= Replace Values - replaces all values for multi-choice and multi-object fields in the load file with
corresponding multi-choice and multi-option fields in the workspace. The fields are merged
regardless of the overlay behavior settings in the environment.

m Use Field Settings - merges or replaces all values for multi-choice and multi-object fields in
the load file with corresponding multi-choice and multi-option fields in the workspace. The
fields are merged according to the overlay behavior settings in the environment.

Folder Info:

In the Folder Info section, select Folder Information Column if you want to use a metadata field to
build the folder structure for the workspace. In the drop-down box, choose the field that you want
Relativity to use for building the folder structure. This field is commonly a source or folder path field.
All folders are built under the Import Destination folder.

When building the folder structure, Relativity looks for backslashes to indicate a new sub-folder. The
following folder structure would result from a field containing field with the value UB
Impairment\Accounts\Bunk Accounts:

=i UB Impairment
=iy Accounts
("] Bunk Accounts

Before importing, you can use the Preview Choices and Folders option to check the number of
choices and folders created by importing the records to the workspace.

Note: The number of folders reported during preview is inaccurate if the folder name contains a
backslash. Avoid using backslashes in folder names.
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Note: Do not select Folder Information Column if you do not want to build a folder structure
based on metadata. When this option is not selected, Relativity loads all documents directly into
the folder indicated by the import destination.

Parent Info:

The Parent Info section will display instead of the Folder info section if you are importing an object
or objects that are children of other objects such as Search Terms Results. If desired, you can check
Parent Information Column and select an object from the drop-down list to determine which parent
object you would like to map it to. Alternatively, you can leave this option unchecked if you do not wish
to map the object with a parent object.

Note: The Parent Information Column can only be unchecked if Overlay only is selected in the
Overwrite section.

Native File Behavior:

In the Native File Behavior section, select Load Native Files if you want to load native files along with
database records. (Do not select this option if you do not have any native files to load.)

In the Native file paths contained in column drop-down box, select a field from your load file that
contains a relative or absolute path to the native files. If the native files reside in a Relativity-
accessible location, click Repository, and select one of these options:

®m Copy files from current location to selected document repository - select this option to
copy files from the location in the selected load file field to the selected document repository.

Note: You can use the Default option to configure an environment level. See the
CopyFilesToRepository instance setting.

% File Repository Preferences >

& Copy files from current location to selected document repository

Document Repository

Wifiles 1019.ctus014128 r1 keura.com™T0154Files' LI Default I
Repository settings cannot be changed when ROC runs in Aspera mode. Click to read more.

ok | Cancel |

= Do not copy files to a Relativity document repository - select this option if the native files
have already been copied to their final location, which is accessible by Relativity.

Note: Selecting this option causes the transfer mode to display as disabled.

Extracted Text:

In the Extracted Text section, set the following options to control how the Full Text or OCR is loaded
into the database. You can import full text or OCR into any long-text field that has been mapped.
These options are only available for selection if you've already mapped a long-text field:
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= Cell contains file location- select this option if your extracted text is in document-level text

files, a
afield

Encoding for undetectable files- select an encoding for the text file. Click

language options or click

o

nd your load file contains a path to those text files. You don't need to select this option if
in your load file contains extracted text.

for additional
ﬂ

Western European (Windows)- indicates the Windows standard encoding for English.

for additional information about encoding.

Unicode - utilizes more than 107,000 characters covering 90 scripts.
Unicode (Big-Endian)- is the same as Unicode, except that the byte order is reversed.

Unicode (UTF-7)- represents Unicode text using a stream of ASCII characters to guar-
antee that the high bit will always be zero.

Unicode (UTF-8)- represents all characters in the Unicode character set using 8-bit
bytes.

Note: A warning message appears if you are missing information required to run the
import. Update the settings for the required options, and click Import File again.

(Optional) To preview information about the content you are importing to the workspace, select
Import, and click one of these options:

®m Preview File - displays the first 1000 documents in the load file. Only mapped fields appear.
Make sure that matched fields that appear in the preview are correct.

" Relativity Desktop Client | Preview Load File [=lE]==]
Recard Mumb | 1:Contral Mumber 1:Date Authaor BCC Extracted Text Custodian =«
» |1 alewis_0013010 20010801 17:56:00.000 | fom: puthinai savita  [new code;
2 azipper_0000050 20010529 15:06:00.000 fronlw: : iolhln.son iglam [rew code’
3 azipper_0000051 Enron broker deal summany [hew code’
4 azipper_0000053 20010530 18:44:00.000 fronj: io_hpson ‘?_Elam [hew code’
[} azipper_0000054 Enron broker dgal summary [hew code’
B azipper_0000055 20010531 18:43:00.000 fronj: io_hpson ‘?_Elam . [new code’
T azipper_000005E Ehron broker dgal summary [new code’
a azipper_0000058 20010601 18:23:00.000 fronj: io_hpson ?_Elam . [hew code’
9 azipper_0000053 Ehron broker dgal summary [new code’
10 azipper_0000060 20010606 18:50:00.000 fronj: io_hpson ?_Elam . [new code.
11 azipper_0000061 Ehron broker dPaI summary [new code.
12 azipper_000002E 20010418 11;28:00.000 frqm: : fqrster t‘:l_tavid . [hew code’
13 azipper_0000027 20070418 16;23:00.000 frqm: : fqrstér t‘:l_tavid [new code’
14 azipper_0000028 20070418 16;35:00.000 fram; : forstér david [hew code’
15 azipper_0000089 mmatsin totlals _l,lr ZﬁDDﬁ [hew code’
18 azipper_0000312 20010430 20:05:00.000 fr_om:_ rostant justin [hew code’
17 azipper_0000457 20010530 20:13:00.000 from: shults bob [new code:
18 azipper_DOOD498 20010531 09.57:00.000 from: forster dvid [new code]
1 szipper_DDDDAZ 20010531 10:00:00.000 from: forster david [new code:
20 szipper_DDDOS 20010531 10:31:00.000 fiom: cummings jchn  [new cods:
21 azipper_0000502 Jcumin shéet'l - [rew code.
22 azipper_0000504 20010531 18:42:00.000 from: haney mike [hew code’
23 azipper_0000505 mike haney &fal&al&a &a?netals L [rew code’
24 azipper_D000EF7 20010413 16:29:00.000 frlom:. rostant Estin [rew code’
25 azinoer OO0DETS 20010417 1950;00.000 from: rostant iustin Tnew code
4 »
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®m Preview Errors - checks all documents for potential loading errors, but displays only the first
1000 errors. If your file does not contain errors, a no errors message appears.

Note: You can use the error report to correct any errors, and then you can re-add the file to
the RDC. Relativity only loads valid records. Records with errors are skipped. You can
export the records for correction and reload. See Handling errors on page 20.

= Preview Choices and Folders - displays the number of choices created in the browser and
the number of choices created by importing the records.

7. Onthe Import menu, click Import File.

Note: If Force folder preview is selected, a confirmation message appears, which contains
information about the number of folders that will be created. Click OK to continue with the import.

8. Review the progress of the import.
You can view the progress of an import through the RDC. Select the following tabs to display specific

information:

® Summary - displays general information about the number of records, processing warnings,
and errors. The following screen shot displays file progress for an import job.

(¥ Import Load File Progress ... — O >

a8
End upload 'f3962a1b-8333-45%e-a2b1-51cbb183520e" file. (778ms) [line 23]

29 of 686 processed

Summary I Ermors | Progress | Wamings I Repart |

Start Time: 2:53:083 BM
Duration: 00:00:14

Time Left to Completion: 00:01:40

Total BRecords: €8¢

Total Processed: B8

Total Processed w/Warnings: 0O
Total Processed w/Errors: 0

Everage f£ile transfer rate: 777.20 EB/sec
Current batch size: 1,000

File Transfer Mode: Aspera, Metadats: Pending
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= Errors - lists any errors encountered during the load. The Errors tab displays any errors that
occur when you import content with the RDC.

Note: When you run an import job, the RDC only imports records with no errors into the
workspace.

= Progress - displays a detailed view of the load progress.
® Warnings - displays information about loading or connection issues.

®m Report - includes the following files that you can export:
o Export Error Report - exports a .csv file with a summary of errors.
o Export Error File - exports a .dat file, which is a document-level load file containing only
records with errors.
= File Transfer Mode - displays the following information:
o Web mode - this mode uses the web server and it is the standard.
o Direct mode - this mode provides faster performance, but requires a connection to the

network hosting the data, as well as specific Windows group permissions. For more
information, see Direct mode on page 13.

9. (Optional) To save your import settings, point to the File menu, and then click Save Import Settings.
Choose a location for the document load file (.kwe). See Saving import settings on page 21.

3.7.3 Importing Yes/No fields on documents
To ensure that you get the correct results when importing into Yes/No fields, use these guidelines:
= No values — Import Yes/No fields containing any values except those specified for Yes values.

= Yes values — Import Yes/No fields containing only "Yes", "Y", "True", "T", and any non-zero integer.
(For example, if you import an "X", the RDC assigns a value of "No" to the documents.)

= Null values — Leave the Yes/No field empty.

Note: You can change the display values on a Yes/No field, but your modification doesn’t affect how the
RDC handles these values during a document import.

3.7.4 Stopping an import or export job

To stop an import or export job in the RDC, click Stop on the import load file progress window.
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[—T—‘ Import Load File Progress ..

522
End upload "1d79f6d7-d142-4dcc-90b4-e2c61b605385 file. (279ms) [line 522]

522 of 686 processed /

Summary | Emors I Progress I Wamings I Report I

Start Time: 4:15:42 EM
Curation: 00:00:1€

Time Left to Completiom: O00:00:05

Total Records: ©E2&

Total Processed: 522

Total Processed w/Warnings: 0
Total Processed w/Errors: 0

Ayverage file transfer rate: 1.38 MB/sec
Current batch size: 1,000

File Transfer Mode: Aspera, Metadata: Pending

Once you click Stop, note that the Progress tab displays the following status messages:

= Job has been stopped — X documents have been transferred.
® Finalizing job...

= Job has been finalized.

Note: Between Finalizing job and Job has been finalized, you could see a variety of job-specific
messages, such as Native file uploads completed.

When you stop a job, only the files from the last configured batch are imported/exported, and the progress
bar is reverted to display this.

For example, when you clicked Stop, the window displayed that 331 out of 371 files had been processed up
to that point; however, because you configured the batch size in the config file to be 10MB, only 263
documents were actually processed because the metadata size for 263 docs is 10MB. Accordingly, the
progress window then displayed a message of Process stopped by user with a processed count of 263 of
371.
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|_'-T—| Import Load File Progress .. —

I Process stopped by userl
End upload "1d79f6d7-d142-4dcc-90b4-e2c61bE0RIEE file. (279ms) [line 522]

522 of 686 processed I

Summary | Emors I Progress I Wamings I Report I

Start Time: 4:15:42 EM
Curation: 00:00:1€

Time Left to Completiom: O00:00:05

Total Records: ©E2&

Total Processed: 522

Total Processed w/Warnings: 0
Total Processed w/Errors: 0

Ayverage file transfer rate: 1.38 MB/sec
Current batch size: 1,000

File Transfer Mode: Aspera, Metadata: Pending

3.8 Importing an image file
You can import image load files that are Opticon-formatted page-level files. Relativity only accepts single
page, Group IV TIFs, or JPGs.

3.8.1 Importing RDC Permissions

The following permissions are required to use the importing feature in Relativity Desktop Client:

Object Security Tab Visibility Admin Operations

= Document: View,

Add, Edit = Documents = Allow Import

3.8.2 Importing images

To import an image load file:
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1. Open the RDC and select a workspace.

2. Onthe Tools menu, point to Import and then click Image Load File. (In the RDC browser, you can
right-click on a specific folder, point to Import and click Image File.) The Import Production Load File
dialog appears.

4 =l
| Relativity Desktop Client EENEGR

File | Tools I Cptions Help

Docum: Import Image Load File... Ctrl+1 ;I

=3 Export ¥ Document Load File... Ctrl+L
Production Load File... Ctrl+P

3. (Optional) To use settings in an existing import file, complete these steps:
a. On the Import Image Load File dialog, click the Import menu, and then select Load Settings.

b. Browse for your load settings file (.kwi) in the Open dialog, and then click Open.

Note: The RDC denotes all image and production import settings with a .kwi file extension.
However, when you select these file types to filter on when you're choosing to save or load
the settings file, the RDC denotes these settings with a .kwx file extension.

c. Click OK on the kCura.EDDS.WinForm dialog. Click Open on Choose Load File dialog. Set-
tings from the file are used to populate fields in the Import Image Load File dialog. (You can
also modify the settings on this dialog as necessary.)

d. Continue with step 5.

4. Onthe Import Image Load File dialog, set the options as necessary. Select the following options:

- Load File - cIickE to browse for your page-level load file. Relativity accepts Opticon format
image load files.

m Start Line - select the line number in the load file where you want the import process to begin.
The default value is 0, which results in loading the entire file.

= Numbering - select one of the following options:
o Use load file page IDs - default setting.

° Auto-number pages - select this option if page IDs in the production are not unique.
For example, you mightimport a set of TIFFs that share a page identifier for each
record. The page identifiers are shared per document and are not unique. The Auto-
number pages option appends the 01, .02, and so on to the page-level identifier, cre-
ating a unique number per page.
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100001,,0:\IMAGES\001\100001_O0OL1.TIF,Y,,,3
100001,,D:\, IMAGES\001\100001_002.TIF,,,,
100001,,0:\ IMAGES\001\100001_003.TIF,,,,
100002,,0:\ IMAGES\001\100002_001.TIF,Y,,,2
100002,,D7\ IMAGES\001)100002_002.TIF,,,,

Note: Enable Auto-number pages if you are importing productions that use
document level numbering without page numbers, and include documents that
contain multiple pages.

= Select Mode - select one of the following options:
° Append Only - load only new records.

° Overlay Only - update existing records only. You must include a workspace identifier in
an overlay load. This field acts as a link indicating to Relativity where to import the data.

o Append/Overlay - adds new records and overlays data on existing records.

Note: Select Append to import the extracted text and natives from a .dat file. Select overlay
when overlaying production images onto the existing documents.

= (Available Only for Production Load Files) Production - select a Relativity production that you
want to upload images to. Only new production sets without a production source appear in this
list.

= (Available Only for Production Load Files) Overlay Identifier - select a field that stores over-
laid document-level Bates information on the document.

Note: The fields in the drop-down menu are fixed-length fields with a manually-applied SQL
index. Note that this is NOT the same as adding the field to the full-text index. Contact your
SQL database administrator to apply an index to a field.

m Repository - if the native files reside in a Relativity-accessible location, click Repository, and
select one of the following options. (You can ignore this option if your files are on your desktop
or laptop, or if you are a consulting partner loading data into our hosting environment.)

° Copy files from current location to selected document repository - select this
option to copy files from the location in the selected load file field to the selected doc-
ument repository.

Note: You can use the Default option to configure an environment level. See the
Instance setting guide.
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% File Repository Preferences x

¥ Copy files from current location to selected document repository

Document Reposiiory

wWiles t019.ctus014128.r1 keura.com \TOD19%Files' ;I Default I
Repository settings cannot be changed when ROC runs in Aspera mode. Click to read more.

ok | Cancel |

° Do not copy files to a Relativity document repository - select this option if the nat-
ive files have already been copied to their final location, which is accessible by Relativ-

ity.

Note: Selecting this option causes the transfer mode to display as disabled.

= (Available Only for Image Load Files) Load Extracted Text - select this option to load new text
for Production documents that may be revised based on redactions. The text files must be
meet these requirements:

° Have .ixt extensions
© Stored in the same directory as TIFF files,

° Named in the same way as the TIFF files

= (Available Only for Image Load Files) Encoding for undetectable files - select an encoding

i

for the text file. Click D for additional language options or click = for additional information

about encoding.
°o Western European (Windows) - indicates the Windows standard encoding for English.

° Unicode - utilizes more than 107,000 characters covering 90 scripts.
° Unicode (Big-Endian) - is the same as Unicode, except that the byte order is reversed.

° Unicode (UTF-7) - represents Unicode text using a stream of ASCII characters to guar-
antee that the high bit will always be zero.

° Unicode (UTF-8) - represents all characters in the Unicode character set using 8-bit
bytes.

. (Optional) To view any errors, click Import, and then select Check Errors. The preview dialog lists
several tabs that may contain information about any errors in your import. See

. Click Import File on the Import menu.

. Review the progress of the import.
You can view the progress of an import through the RDC. Select the following tabs to display specific
information:
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= Summary - displays general information about the number of records, processing warnings,
and errors. The following screen shot displays file progress for an import job.

(¥ Import Load File Progress ... — O >

a8
End upload ‘3362a1b-8333-45%e-a2b1-51cbb183520e" file. (778ms) [line 23]

&9 of 686 processed

Summary I Ermors I Progress | Wamings I Report I

Start Time: 2:53:02 PM
Duration: 00:00:14

Time Left to Completion: 00:01:40

Total Records: €8¢

Total Processed: 85

Total Processed w/Warnings: O
Total Processed w/Errors: 0

Average file transfer rate: 777.20 EBfsec
Current batch size: 1,000

File Transfer Mode: Aspera, Metadats: Pending

= Errors - lists any errors encountered during the load. The Errors tab displays any errors that
occur when you import content with the RDC.

Note: When you run an import job, the RDC only imports records with no errors into the
workspace.

= Progress - displays a detailed view of the load progress.
= Warnings - displays information about loading or connection issues.

= Report - includes the following files that you can export:
o Export Error Report - exports a .csv file with a summary of errors.

o Export Error File - exports a .dat file, which is a document-level load file containing only
records with errors.

= File Transfer Mode - displays the following information:
o Web mode - this mode uses the web server and it is the standard.
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o Direct mode - this mode provides faster performance, but requires a connection to the
network hosting the data, as well as specific Windows group permissions. For more
information, see

8. (Optional) To save your import settings, point to the File menu, and then click Save Import Settings.
Choose a location for the production load file (.kwi). See

3.9 Importing a production file

You can import external productions into Relativity through the Relativity Desktop Client.

This is useful when a case team, after a production goes out the door, needs access to documents as they
were in the production and needs them available for searching.

3.9.1 Special considerations
Follow these guidelines when you want to work with externally created production:

® Create a production set in Relativity. The numbering imported with the Opticon file functions as
sequential Bates numbering. (The Bates label setting in the imported production is not used.)
= Run the production with the external tool to generate the following files:

° Document level control file - it should minimally contain an identifier field that is also present
in the workspace, and a new production or Bates number.

Note: When loading a production set into Relativity, you may map a production numbering
field to the identifier field, as long as it is unique.

o Page level Opticon file - it should use the production or Bates numbering scheme.

= Qverlay document level load file in Relativity.

® | pading documents into a 'staging' production marks the production set as produced.

= When loading a production set into Relativity, the systems loads the newly created documents into
the root folder. It may be prudent to move these documents to a new folder to ensure proper foldering
and security of the documents.

= Using Append/Overlay during the metadata import creates new documents that did not have images,
but these documents aren't associated with the production. To associate these files with a production
set, create and load an image load file pointing to placeholder images and then overlay the metadata.
Using the Overlay Only option shows an error on any document not already loaded, and you can use
the error file as a list to identify documents that may not have had images.

3.9.2 Importing RDC Permissions

The following permissions are required to use the importing feature in Relativity Desktop Client:

Object Security Tab Visibility Admin Operations

® Document: View,

Add, Edit = Documents = Allow Import
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3.9.3 Importing a production

To import a production, use these steps:

1. Open the RDC and select a workspace.

2. Onthe Tools menu, point to Import, and then click Production Load File. (In the RDC browser, you
can right-click on a specific folder, point to Import and click Production File.) The Import Production
Load File dialog appears.

7 5
| Relativity Desktop Client EEREER T

File | Tools I Options Help

Diocume Import Image Load File... Ctrl+I LI

=3 Export L Document Load File... Ctrl+L
Production Load File... Cirl+P

3. (Optional) To use settings in an existing import file, complete these steps:
a. Onthe Import Production Load File dialog, click the Import menu, and then select Load Set-
tings.

b. Browse for your load settings file (.kwi) in the Open dialog, and then click Open.

Note: The RDC denotes all image and production import settings with a .kwi file extension.
However, when you select these file types to filter on when you're choosing to save or load
the settings file, the RDC denotes these settings with a .kwx file extension.

c. Click OK on the kCura.EDDS.WinForm dialog. Click Open on Choose Load File dialog. Set-
tings from the file are used to populate fields in the Import Production Load File dialog. (You
can also modify the settings on this dialog as necessary.)

d. Continue with step 5.

4. On the Import Production Load File dialog, set the options as necessary.

- Load File - cIickm to browse for your page-level load file. Relativity accepts Opticon format
image load files.

m Start Line - select the line number in the load file where you want the import process to begin.
The default value is 0, which results in loading the entire file.

= Numbering - select one of the following options:
o Use load file page IDs - default setting.

° Auto-number pages - select this option if page IDs in the production are not unique.
For example, you might import a set of TIFFs that share a page identifier for each
record. The page identifiers are shared per document and are not unique. The Auto-
number pages option appends the 01, .02, and so on to the page-level identifier, cre-
ating a unique number per page.
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100001,,0:\IMAGES\001\100001_O0OL1.TIF,Y,,,3
100001,,D:\, IMAGES\001\100001_002.TIF,,,,
100001,,0:\ IMAGES\001\100001_003.TIF,,,,
100002,,0:\ IMAGES\001\100002_001.TIF,Y,,,2
100002,,D7\ IMAGES\001)100002_002.TIF,,,,

Note: Enable Auto-number pages if you are importing productions that use
document level numbering without page numbers, and include documents that
contain multiple pages.

= Select Mode - select one of the following options:
° Append Only - load only new records.

° Overlay Only - update existing records only. You must include a workspace identifier in
an overlay load. This field acts as a link indicating to Relativity where to import the data.

o Append/Overlay - adds new records and overlays data on existing records.

Note: Select Append to import the extracted text and natives from a .dat file. Select overlay
when overlaying production images onto the existing documents.

= (Available Only for Production Load Files) Production - select a Relativity production that you
want to upload images to. Only new production sets without a production source appear in this
list.

= (Available Only for Production Load Files) Overlay Identifier - select a field that stores over-
laid document-level Bates information on the document.

Note: The fields in the drop-down menu are fixed-length fields with a manually-applied SQL
index. Note that this is NOT the same as adding the field to the full-text index. Contact your
SQL database administrator to apply an index to a field.

m Repository - if the native files reside in a Relativity-accessible location, click Repository, and
select one of the following options. (You can ignore this option if your files are on your desktop
or laptop, or if you are a consulting partner loading data into our hosting environment.)

° Copy files from current location to selected document repository - select this
option to copy files from the location in the selected load file field to the selected doc-
ument repository.

Note: You can use the Default option to configure an environment level. See the
Instance setting guide.
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% File Repository Preferences x

¥ Copy files from current location to selected document repository

Document Reposiiory

wWiles t019.ctus014128.r1 keura.com \TOD19%Files' ;I Default I
Repository settings cannot be changed when ROC runs in Aspera mode. Click to read more.

ok | Cancel |

° Do not copy files to a Relativity document repository - select this option if the nat-
ive files have already been copied to their final location, which is accessible by Relativ-

ity.

Note: Selecting this option causes the transfer mode to display as disabled.

= (Available Only for Image Load Files) Load Extracted Text - select this option to load new text
for Production documents that may be revised based on redactions. The text files must be
meet these requirements:

° Have .ixt extensions
© Stored in the same directory as TIFF files,

° Named in the same way as the TIFF files

= (Available Only for Image Load Files) Encoding for undetectable files - select an encoding

i

for the text file. Click D for additional language options or click = for additional information

about encoding.
°o Western European (Windows) - indicates the Windows standard encoding for English.

° Unicode - utilizes more than 107,000 characters covering 90 scripts.
° Unicode (Big-Endian) - is the same as Unicode, except that the byte order is reversed.

° Unicode (UTF-7) - represents Unicode text using a stream of ASCII characters to guar-
antee that the high bit will always be zero.

° Unicode (UTF-8) - represents all characters in the Unicode character set using 8-bit
bytes.

. (Optional) To view any errors, click Import, and then select Check Errors. The preview dialog lists
several tabs that may contain information about any errors in your import. See

. Click Import File on the Import menu.

. Review the progress of the import.
You can view the progress of an import through the RDC. Select the following tabs to display specific
information:
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= Summary - displays general information about the number of records, processing warnings,
and errors. The following screen shot displays file progress for an import job.

(¥ Import Load File Progress ... — O >

a8
End upload ‘3362a1b-8333-45%e-a2b1-51cbb183520e" file. (778ms) [line 23]

&9 of 686 processed

Summary I Ermors I Progress | Wamings I Report I

Start Time: 2:53:02 PM
Duration: 00:00:14

Time Left to Completion: 00:01:40

Total Records: €8¢

Total Processed: 85

Total Processed w/Warnings: O
Total Processed w/Errors: 0

Average file transfer rate: 777.20 EBfsec
Current batch size: 1,000

File Transfer Mode: Aspera, Metadats: Pending

= Errors - lists any errors encountered during the load. The Errors tab displays any errors that
occur when you import content with the RDC.

Note: When you run an import job, the RDC only imports records with no errors into the
workspace.

= Progress - displays a detailed view of the load progress.
= Warnings - displays information about loading or connection issues.

= Report - includes the following files that you can export:
o Export Error Report - exports a .csv file with a summary of errors.

o Export Error File - exports a .dat file, which is a document-level load file containing only
records with errors.

= File Transfer Mode - displays the following information:
o Web mode - this mode uses the web server and it is the standard.
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o Direct mode - this mode provides faster performance, but requires a connection to the
network hosting the data, as well as specific Windows group permissions. For more
information, see Direct mode on page 13.

8. (Optional) To save your import settings, point to the File menu, and then click Save Import Settings.
Choose a location for the production load file (.kwi). See Saving import settings on page 21.

3.9.3.1 Saving the progress log

Once your import or export job is complete, you have the option of saving the event log from that job to your
machine. You can do so by clicking Save Progress Log on the progress window of the RDC.

[+ Import Load File Progress ... - O *

All records have been processed

90000 of 30000 processed Hide Detail

Summary |Error5 I Progressl Wamings I Report I

Start Time: 1:56:3Z2 EM L
Finish Time: 2:01:31 BM

Duration: 00:04:58

Total Records: 30000

Total Processed: 30000

Total Processed w/Warnings: 0
Total Processed w/Errors: 0O

W

Metadata: Direct - Files: not copied - SQL Insert Mode: Bulk Save Progress Log l

Note the following details:

= This log comes in the form of a temp folder containing all the messages displayed in the interface
while the import or export job was running.

= The option to save the progress log is only available if you've set the LogAllEvents value to True in the
RDC configuration file.

3.10 Import errors for Desktop Client

Note: When an item-level error occurs in a load file, Relativity Desktop Client uses the proper delimiter
automatically so that when users access the load file, they will not experience the error.

The following table lists the most common import errors found in the Relativity Desktop Client, including their
messages and fixes.

Message Fix
: Change the date information to one of the standard date
Invalid date.
formats.
Invalid boolean. Change data to a YES or NO format.
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Message
Invalid decimal.
Invalid integer.

Input length exceeds maximum set length of
<max length> for this VarChar field.

Input length exceeds maximum set length of
<max length> for the associated object field
<name>.

Error uploading file. Skipping line.

File upload failed. Either the access to the
path is denied or there is no disk space avail-
able.

File '<file name>' not found.
File '<file name>' contains 0 bytes.

Identifier Value not set.

Choice name specified twice for this record.

Proposed choice name exceeds 200 char-
acters.

User does not exist in the system or is not
available for assignment.

Document has been previously processed in
this file

Error: full text file specified does not exist.
There are an invalid number of cells in this
row - expecting:<expected>, actu-
al:<actual>.

- This document identifier does not exist in
the system - no document to overwrite

A document with identifier <document iden-
tifier> already exists in the system

This file identifier exists attached to another
document with selected key field {0}

This file identifier exists attached to another
document with selected ArtifactID {0}

This file identifier exists attached to another
document

Document is already in the selected pro-
duction

Fix
Change the data to a valid number.
Change the data to an integer.

Increase the character restriction on the field.

Increase the character size of associated object.

Verify and correct line information.

Verify disk space is available and check permissions on data
server.

Verify the file is available in path provided.
No data exists in the file.

The Overlay Identifier field has not been mapped. Map the
Overlay Identifier field.

Two choice name fields are titled identically. Each choice
name should be unique from all others in the load file.

Rename the specified choice to something less than 200
characters.

Email used in the entity file is not associated with any entity in
the system.

Same ID trying to load twice.

Verify the path of extracted text file.

Remove the extra column delimiter from load file.

Overlay unavailable. You must append the data.

The identifier field already exists in the system. You need to
do an overlay to overwrite the existing data.

Same ID trying to load twice.
Same ID trying to load twice.
Duplicate page ID in a different document.

The Bates number is already loaded.

Because you can't overlay into an existing production, you
must create a new production or replace the images
manually on the back end.
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Message Fix

This document contains redactions or high-
lights that can't be overwritten

There is no image specified on this line Make sure image id is present in load file.

One of the files specified for this document
does not exist

The image file specified is not a supported  This can't be loaded without conversion to an approved

Delete the markups.

Make sure image files are present for represented path.

format in Relativity format.
The file being uploaded is empty No data exists in the file so it can't be loaded.
The identifier field for this row is either empty

Verify that an identifier exists.
or unmapped

The identifier specified on this line has been
previously specified in the file

The document specified has been secured
for editing.

Your account does not have rights to add a
document or object to this case

A non-unique associated object is specified Two objects with the same name exist in the workspace.
for this new object. Identify the duplicates and change one of their names.
Your account does not have rights to add an
associated object to the current object.

An object field references a child object
which does not exist.

This record's Overlay Identifier is shared by
multiple documents in the case, and cannot Use a unique ID to overlay the data
be imported.

Make sure the identifier field is unique or overlay data.
Change security permissions to allow document edit rights.

Change security permissions to allow document add rights.

Change security permissions to allow updates to object.

Add a child object.
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4 Exporting with the RDC

You can use the Relativity Desktop Client (RDC) to export production sets, saved search results, and
folders. When you perform an export, the RDC automatically creates top-level folders for images, text, and
natives. The RDC exports all documents included in the production set, search result, or folder.

. Production
L WaLooonl
o IMAGES
o IMGo0001
L MATIVES
oo MATRVENDNOL
L TEXT
| TEXTOO001

Note: You need to install the RDC on your computer before you can perform an export.

4.1 Exporting RDC Permissions

The following permissions are required to use the exporting feature in Relativity Desktop Client:

Object Security Adml_n Oper-
ations
® Document: Local Access (Download, Copy Text)
Note: This is required when exporting long-text cells greater than the value defined by the = Allow
MaximumLongTextSizeForExportInCell instance setting, the default value of which is Export
1048576.

4.2 Technical considerations for .kwx files

Note the following:

m  kwx stands for kCura Win edds eXport.

= The .kwx file you call on when you load export settings is a SOAP-serialized file used to run the
export.

= SOAP is a protocol based on XML. It's designed specifically to transport or store procedure calls
using XML. It does this by converting fields and properties of an object into the serial format of an
XML stream.

= When you run an export, the RDC collects all the inputs from the form into an object in memory. The
RDC also passes the object on to the export process.
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= When you save an export settings object, Relativity passes that object in memory to a SOAP seri-
alizer. The SOAP serializer writes that object’s settings to XML.

= When you load export settings, Relativity takes a serialized object and deserializes it to an in-memory
settings object. Then it loops over all the properties and sets the actual form values to reflect those
settings.

4.3 Exporting a production set

You can export the contents of a production set created in Relativity through the RDC.

4.3.1 Exporting RDC Permissions

The following permissions are required to use the exporting feature in Relativity Desktop Client:

Object Security Adml.n Oper-
ations
® Document: Local Access (Download, Copy Text)
Note: This is required when exporting long-text cells greater than the value defined by the = Allow
MaximumLongTextSizeForExportInCell instance setting, the default value of which is Export
1048576.

4.3.2 Exporting a production set

To export a production set:

1. Open the RDC and select a workspace.

2. Onthe Tools menu, point to Export and then click Production Set.

The Data Source tab in the Export Production window appears.

Help

Production Set...

Saved Search..,

Folder...

Folder and Subfolders...

3. (Optional) To use settings in an existing export file, use these steps:
a. Click the File menu, and select Load Export Settings.

b. Browse for your export settings file (.kwx) in the Open dialog.
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c. Select a production set, and click OK. Your production set appears on the Data Source tab,
and the settings from the file populate the Destination Files tab. (You can also modify any set-
tings on the Data Source and Destination Files tab as necessary.)

Note: On the Destination Files tab, you may want to select Overwrite Files if you're re-
exporting the same group of files to the previously used location.

'/ Relativity Desktop Client | Select Production [

Mame |

anu
Mot run

Patent Production 1a
Patent Production 2
Patent Production 3
Patent Production 4
Patent Production 5

Patent Production Set 1

Patent Production Set 10

Patent Production Set 8
Patent Production Set 8 (1)

d. Continue with step 7.

4. Onthe Data Source, select a production set in the Productions box. Update the remaining options
as necessary.

The Data Source tab appears when you select the option to export production sets, saved searches,
folders, and subfolders. Each of these have similar actions, but you may want to select different
settings for them.

Note: The Production:: Begin Bates and Production:: End Bates reflective fields automatically
populate in the Selected Columns.
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Peta Seurce | Destination Fles |
Productions
| Fissponsive Documents =]

Selected Columns Start Export al Record §
Enalyhes index - Beg Bates [1 o
Saifnct 1D End Bates

Fathor

Batch

Bach: Assigned Te
Eatch:: Balch Set.
Baich: Status
Catral Musribar
Comversation
Cormearsation

Al ¥
lel>

Cusiodiam

Date Created

Date Last Modified
[iste Recaned

File Size -
i m [

On the Data Source tab, you can set the following options for the data that you want to export:

= Views - select a view for the data that you want to export.

= Selected Columns - choose the fields that you want to export by moving them to the Selected
Columns box. The box on the right displays all available fields, but the RDC only exports the
fields in the Selected Columns box.

Note: If you select any reflected fields, only the value for the production you select displays.

m Start Export at Record # - select a record number that identifies the initial document for
export. The RDC begins by exporting the document with this record number and continues by
exporting documents with subsequent record numbers.

= (Available only for Saved Searches, Folders, and Subfolders) Production Precedence - click

] to display the Pick Production Precedence dialog where you can select a group of pro-
duced documents for export instead of the original images.
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[ ek producton precedence
" Original Images
% Produced Images
I Include original images for documents that haven't been produced
Auailable Productions Selected Productions
Acme Production
Prod 04

Prod 03
Prod 02

>3

+
v OK

— _ Conedl |

Al

m Select the images that you want to export:
° Original Images - only the original, non-produced images.

° Produced Images - a produced version of the images.

° Include original images... - original images for the documents that are not in a spe-
cified production.

= Move the productions that you want exported to the Selected Productions box. To move pro-
ductions between columns, highlight them and click the Right or Left single or double arrows.
Use the Up and Down arrows to order the precedence of the fields.

Note: The RDC only produces one version of each document. The version of the document in the
topmost production exports first. If the document doesn't exist in the topmost production, Relativity
checks for the document in the second production and so on. If the document is not a part of any of
the selected productions, and Include original images ... is enabled, then the original document
produces.

5. Select the Destination Files tab.
On the Destination tab, you can set options that control how the files in folders, searches, and
production sets are exported. The Export dialog displays this tab when you select an Export option
from the Tools menu, or when you right-click on a folder or workspace in the RDC. The Destination
tab displays the same options when you export files in folders, searches, or production sets.
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@ Relativity Desktop Client | Export Saved Search

— O *
— Text and Native File Names
MNamed after: | Select... LI |
[~ Append original filename
—Image
¥ Export Images
Data File Format: | Select... |
File Type: | Select... |
—Native
¥ Export Native Files ¥ Export rendered PDF's
—Metadata
Data File Format: | Select... =l
Data File Encoding: | Select... =l | 2]
[~ Export Text Field as Files
Text File Encoding: | Select... =
Text Preoedenoe:l |

[¥ Export Multiple Choice Fields as Nested

File
Dats Source Destnation s | <
— Export Location
[Select a folder ... |
[~ Overwrite Files
—Physical File Export —File Path
¥ Copy Files From Repository (¥ |Use Relative Paths
—\olume Information " Use Absolute Paths
Prefis: IVOL " Use Prefix I
Start#:|1 3: #ofdigits:IE 3:
Max Size (MB): m&n : —Load File Characters
Column: IJ (ASCII:020) vl
—Subdirectory Information
Image Preﬁx:IIMG QUD’EB:IIJ (ASCII:254) vl
Native Prefix: [NATIVE Newline® (ASCIN72) <]
Text Prefix: ITEXT
Multi—VaIue:I: (ASCII:059) vl
PdfPrefic: [PDF
Nested Value: I \ (ASCII:092) vl
Start #: |1 3: #ofdigits:|3 3: } :
Max Files:[500 =

Note: In the Text and Native File Name section, the Named after option is available only for

Production Sets.

Complete the fields on the Destination Files tab. See Fields on the Destination Files tab on the next

page.

After you select your export settings, select File and click Run.

Note: A warning message appears if you are missing information required to run the export.
Update the settings for the required options, and click Run again.

Review the progress of the export.

You can view the progress of an export through the RDC. Select the following tabs to display specific

information:

= Summary - displays general information about the number of records, processing warnings,
and errors. The following screen shot displays file progress for an export job.

HRelativity
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Y Export Saved Search Progress .. -

161
ltem ‘AZIPPER_DO0VETE file 717 fced-fdfd-4430-a657-892e1b036ack’ processed. [line 162]

&3 of 371 processed

Summary | Errors | Progress | Wamings | Report |

Start Time: 3:26:58 BEM
Curation: 00:00:11

Time Left to Completion: 00:00:54

Total Records: 371

Totzl Processed: &3

Totel Processed w/Warnings: 0O
Totzl Processed w/Errors: O

Average f£ile transfer rate: 478.71 EB/sec
Current bkatch size: 1,000

Metadata: - Files: Direct - SQL Insert Mode: Bulk

= Errors - lists any errors encountered during the load. The Errors tab displays any errors that
occur when you export content with the RDC.

= Progress - displays a detailed view of the load progress.
= Warnings - displays information about loading or connection issues.

= Report - includes the following files that you can export:
o Export Error Report - exports a .csv file with a summary of errors.

o Export Error File - exports a .dat file, which is a document-level load file containing only
records with errors.
= File Transfer Mode - displays the following information:
o Web mode - this mode uses the web server and it is the standard.
o Direct mode - this mode provides faster performance, but requires a connection to the

network hosting the data, as well as specific Windows group permissions. For more
information, see Direct mode on page 13.

9. (Optional) To save your export settings, point to the File menu, and click Save Export Settings.
Choose a location for the export settings file (.kwx).

4.3.3 Fields on the Destination Files tab

The Destination Files tab contains the following sections with their respective fields:

tH Relativity Desktop Client Guide .



= Export Location - select a target directory for exporting folders, searches, and production sets. Click

—I to browse for a location. Select Overwrite Files to overwrite any existing files of the same name
in the target export directory.

= Physical File Export - select the Copy Files From Repository option. This is the default option and
copies files from the file server to the specified export location. If you don't select Copy Files From
Repository, Relativity doesn't copy the files to the export location. Instead, the exported load files ref-
erence the repository location of the files.

= Volume Information - controls the naming and size of the volume identifier. Set the following options
in this section:

o

o

Prefix - enter the alpha prefix for the volume identifier.

Start # - select the first number used for the numeric section of the volume identifier. Multiple
volumes increment numbers during export creating unique volume identifiers.

# of Digits - select the number of digits attached to the prefix. (For example, if you select 3, the
output is VOL001, VOL002, and so on.)

Max size - select the maximum size allowed for each volume in MBs.

= Subdirectory Information - controls the naming and size of volume subfolders. Set the following
options in this section:

o

o

o

Image Prefix - enter the alpha prefix for the subdirectory that stores exported images.

Native Prefix - enter the alpha prefix for the subdirectory that stores exported native files.
Text Prefix - enter the alpha prefix for the subdirectory that stores exported extracted text files.
Pdf Prefix - enter the alpha prefix for the subdirectory that stores exported extracted PDF files.
Start # - select the starting number for the subdirectories.

# of Digits - select the number of digits of the subdirectory prefix (For example, if you select 3,
the output is IMG001, IMG002, and so on.)

Max Files - select the number of files to store in each subdirectory.

= File Path - controls how the export path for the files is referenced. Select one of the following options:

[e]

[0}

o

Use absolute paths - paths to exported files are represented as absolute paths.
C:\ Desktop\VOLOO1\NATIVEOO1\AS000001.msg

Use relative paths - paths to exported files are represented as relative paths.
AVOLOO1\NATIVEOO1\AS000001.msg

Use prefix - a prefix is added to the relative path, such as a CD drive letter.
D:\VOLOO1\NATIVEOO1\AS000001.msg

® | oad File Characters - select the delimiters to use in a document-level load file when Data File
Format in the Metadata section is set to Custom. Select the following options as necessary:

o

o

Column - this delimiter separates columns in the load file.

Quote - this delimiter qualifies the text in each field of the load file.
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o Newline - this delimiter signifies the end of any extracted text or long text field in the load file.
° Multi-Value - this delimiter separates different choices within a choice field.

o Nested Value - this delimiter indicates the hierarchy of choices within a choice field.

= Text and Native File Names - select the following options for naming exported native and extracted
text files:

Note: The following field types are supported by this feature: Date, Decimal, Fixed-Length Text,
Single Choice, Whole Number, and Yes/No.

= (Available Only for Production Sets) Named after - select one of the following naming convention for
exported files:

o ldentifier - select this option to name the files after the identifier for your workspace.

° Beginning production number - select this option to name the files after the production num-
ber. (This number may be the Bates number for a production.)

° Custom - select this option to name the native and text files in an export by appending them
with either a control number or production begin bates and optionally, a field of your choice.
To select custom naming options for your exported native and text files, do the following:

o Select Custom from the Named after drop-down menu.

CIickII] to the right of the Named after drop-down menu.

° Select either the control number or production begin bates naming option from the drop-
down menu.

o -

Optionally, to append a field or custom text to the file name, click .
o Select the desired spacing option from the _ (underscore) drop-down menu.

° To either add custom text to the name or to add a field to the name, do the following:
¢ Toinclude custom text as part of the name, choose the Custom Text... option in
the drop-down menu and enter the desired custom text in the textbox underneath
the Custom Text... drop-down menu.

* Toinclude afield as part of the file names, select the desired field option from the
Custom Text... drop-down menu. If a field is empty in a workspace it will not dis-
play as part of the file name even if selected from the Custom Text... drop-down
menu.

Note: If a boolean field is selected, the name of the field will be displayed and
not the value. For example: JWOLFE_009 confidential-HAS IMAGES.

° Optionally, to add an additional field or custom text after the previously selected options,
+
click —l

o Select the desired spacing option from the _ (underscore) drop-down menu.
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° To either add additional custom text to the name or to add an additional field to the
name, do the following:

¢ Toinclude additional custom text as part of the name before a field, choose the
Custom Text... option in the drop-down menu and enter the desired custom text
in the textbox underneath the Custom Text... drop-down menu.

¢ Toinclude an additional field as part of the name, select the desired field option
from the Custom Text... drop-down menu. If a field is empty in a workspace it will
not display as part of the file name even if selected from the Custom Text... drop-
down menu.

Note: If a boolean field is selected, the name of the field will be displayed and
not the value. For example: JWOLFE_009_confidential-HAS IMAGES.

° Click Apply to save the current naming options.

Note: If a file is not found in any of the production sets, the name will revert to the
control number or production begin bates regardless of which naming options you
have selected.

= Append original file - Select this option to append the original file name which is defined as the file
name as it was on disk to the end of the exported file name.

= |mage - determines whether to include images in an export and sets the format of the load file. Set
the following options:

o Check Export Images - select this option to include images in the export. (You must set the
Data File Format and the File Type when you exportimages.)

o Data File Format - select one of these formats for image-level load file:
e Opticon

e |IPRO

° File Type - select one of these file types:
¢ Single-page TIF/JPG

¢ Multi-page TIF
 PDF
= Native - controls which files are exported by Relativity Desktop Client.
o Export Native Files - select to export native files.

o Export rendered PDF's - select to export PDF files. This option is not available when export-
ing a Production set.

= Metadata - use the following options to control the export of the document-level load file and extrac-
ted text:
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[e]

Data File Format - select a the format for the document-level load file you're exporting:

¢ Comma separated (.csv)

¢ Concordance (.dat) - load file exports with the standard Concordance delimiters.

¢ Custom (.txt) - load file exports with the custom delimiters that you select in the Load
File Characters section.

e HTML (.html) - load file is in HTML and contains hyperlinks to launch any exported files.

o

Data File Encoding - select an encoding for the document-level load file from the drop-down

box. Click L] for additional options.

o

Export Text Field as Files - determines the export of the extracted text or OCR. Select this

option if you want to export files as individual document-level text files, with one file per doc-
ument. The RDC includes text as part of your load file if you deselect this option.

° Text File Encoding - select the encoding for the document-level text files. ClickEI for addi-

tional options.

o

Text Precedence - select and assign an order to long text fields that Relativity checks for text

when performing an export. You must select one or more long text fields to use this func-

tionality. CIickEl to display the Pick Text Precedence pop-up. To move fields between
columns, highlight them and click the Right or Left single or double arrows. Use the Up and
Down arrows to order the precedence of the fields.

-
|‘_E,-| Pick Text Precedence

HAorailable Long Text Fields

BCC

CC

Comments
Conversation |Ds
Source File

To

S5
Selected Long Text Fields
OCR Text
Extracted Text
>3
—_ l|
= b
«€ L
[
Ok | f
N
Cancel J

If you add any fields to the Selected Long Text Fields column, Relativity adds the Text
Precedence column as the last column in the load file. During an export, Relativity checks the
topmost field in the Selected Long Text Fields column for text, and if the field is null, it checks
the next field in order of precedence for text. When it finds a field that contains text, Relativity

tHRelativity
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adds the contents of that field to the Text Precedence column in the document load file, and
then continues checking the fields for the next document.

For example, you want the Text Precedence column in the load file to contain the contents of
the OCR Text field when it is available for a document and the contents of the Extracted Text
field when the OCR Text for a document is null. In the Pick Text Precedence pop-up, you add
the OCR Text as the first field in the Selected Long Text Fields column followed by the

Extracted Text field.

Note: If you want to improve export performance, you don't need to add all of the long text
fields you select in the Pick Text Precedence pop-up to the Selected Columns option on the
Data Source tab. When you don't select these fields on the Data Source tab, but you add
them to Selected Long Text Fields column, the RDC adds the content of these fields to the
Text Precedence column as described above. When you add the long text fields on the Data
Source tab, Relativity adds these columns to the document level load file.

The Precedence Text column displays the file path to the exported files if you select the Export
Text Field as Files checkbox.

Export Multiple-Choice Fields as Nested - select this option to maintain the hierarchy of
Relativity multiple-choice lists, when applicable. The nested value delimiter, a backslash, sep-
arates child choices.

4.4 Exporting a saved search

Case
1

Case

Case

Case

Production

Has native Has image
production production

set

YES

YES

NO

NO

set

NO

YES

NO

NO

Document Export options

YES

YES

YES

NO

Include original
images for doc-
uments that haven't
been produced

produced

. YES
images
produced YES
images
erglnal N/A
images
f)rlglnal N/A
images

EXPORT res-
ults (.opt file)

empty .opt file N/A

.optfile con-  for production use
tains entries  image place-
with produced holder: when no

images image exists
.opt file con-

ta.lns e.nt.rles N/A

with original

images

empty .opt file N/A

4.4.1 Exporting RDC Permissions

The following permissions are required to use the exporting feature in Relativity Desktop Client:
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Object Security

® Document: Local Access (Download, Copy Text)

Note: This is required when exporting long-text cells greater than the value defined by the
MaximumLongTextSizeForExportinCell instance setting, the default value of which is
1048576.

Admin Oper-
ations

= Allow
Export

4.4.2 Exporting a saved search
To export a saved search:
1. Open the RDC and select a workspace.

2. Onthe Tools menu, point to Export and click Saved Search.
The Data Source tab in the Export Production window appears.

| Relativity Deskiop C e

Opticns Help

Import  * |
Export Proeduction Set...

Saved Search...

Folder...

Felder and Subfolders..,

3. (Optional) To use settings in an existing export file complete these steps:

a. Click the File menu, and select Load Export Settings.

b. Browse for your export settings file (.kwx) in the Open dialog.

c. Selectasaved search, and click OK. Your saved search is listed on the Data Source tab, and
the settings from the file are used to populate the Destination Files tab. (You can also modify

any settings on the Data Source and Destination Files tab as necessary.)

Note: On the Destination Files tab, you may want to select Overwrite Files if you are

re-exporting the same group of files to the previously used location.
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.
51 Relativity Desktop Client | Select Saved Search  (SNES

Mame -

Patent Search

Payoff Search

Pivot on Responsiveness
Precedence Search

Privilege Check

Privilege Check - Copy
Production Guality Check
Redacted Documents
Redacted Documents - Copy
Requires Manual Reeun Search
Responsive Search

Responsive Search 2 -

m

1 | i | »

d. Continue with step 4.

4. Onthe Data Source, select a saved search in the Searches box. Update the remaining options as
necessary.
The Data Source tab appears when you select the option to export production sets, saved searches,
folders, and subfolders. You will see similar options on the tab for each of these actions, but you may
want to select different settings for them. The following screen shot uses a production set as an
example, but the settings are the same when exporting production sets, saved searches, folders, and
subfolders.
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On the Data Source tab, you can set the following options for the data that you want to export.
Depending on the type of data you want to export, the dropdown updates accordingly. Select from the

following:

= Views - Folders and subfolders - select a view for the data that you want to export.

Searches - Saved Search - select a saved search you want to export.

Productions - Production set - select a production set you want to export

Selected Columns - choose the fields that you want to export by moving them to the Selected
Columns box. The box on the right displays all available fields. Only the fields in the Selected
Columns box are exported.

Note: If a reflected production field is selected for Selected Column, the RDC doesn't narrow
down the field to a specific production. The reflected field for all productions is included.

Start Export at Record # - select a record number that identifies the initial document for
export. The RDC exports the document with this record number and continues exporting doc-
uments with subsequent record numbers.

(Available only for Saved Searches, Folders, and Subfolders) Production Precedence - click

L] to display the Pick Production Precedence dialog where you can select a group of pro-
duced documents for export instead of the original images.
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o Select the images that you want to export:
¢ Original Images - export only the original, non-produced images.

¢ Produced Images - export a produced version of the images.

¢ Include original images... - export original images for the documents that are
not in a specified production.

° Move the productions that you want to exported to the Selected Productions box. To
move productions between columns, highlight the production and click the Right or Left
single or double arrows. Use the Up and Down arrows to order the precedence of the
fields.

Note: Any produced native files will be exported as a native instead of an image. Only
one produced image is exported based on precedence in the list. If the document is in
the topmost production, that version is exported. If not, Relativity checks for the
document in the second production and so on. If the document is not a part of any of
the selected productions, and Include original images ... is enabled, then the
original document is produced.

5. Select the Destination Files tab.
On the Destination tab, you can set options that control how the files in folders, searches, and
production sets are exported. The Export dialog displays this tab when you select an Export option
from the Tools menu, or when you right-click on a folder or workspace in the RDC. The Destination
tab displays the same options when you export files in folders, searches, or production sets.
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@ Relativity Desktop Client | Export Saved Search

— O *
— Text and Native File Names
MNamed after: | Select... LI |
[~ Append original filename
—Image
¥ Export Images
Data File Format: | Select... |
File Type: | Select... |
—Native
¥ Export Native Files ¥ Export rendered PDF's
—Metadata
Data File Format: | Select... =l
Data File Encoding: | Select... =l | 2]
[~ Export Text Field as Files
Text File Encoding: | Select... =
Text Preoedenoe:l |

[¥ Export Multiple Choice Fields as Nested

File
Dats Source Destnation s | <
— Export Location
[Select a folder ... |
[~ Overwrite Files
—Physical File Export —File Path
¥ Copy Files From Repository (¥ |Use Relative Paths
—\olume Information " Use Absolute Paths
Prefis: IVOL " Use Prefix I
Start#:|1 3: #ofdigits:IE 3:
Max Size (MB): m&n : —Load File Characters
Column: IJ (ASCII:020) vl
—Subdirectory Information
Image Preﬁx:IIMG QUD’EB:IIJ (ASCII:254) vl
Native Prefix: [NATIVE Newline® (ASCIN72) <]
Text Prefix: ITEXT
Multi—VaIue:I: (ASCII:059) vl
PdfPrefic: [PDF
Nested Value: I \ (ASCII:092) vl
Start #: |1 3: #ofdigits:|3 3: } :
Max Files:[500 =

Note: In the Text and Native File Name section, the Named after option is available only for

Production Sets.

Complete the fields on the Destination Files tab. See Fields on the Destination Files tab on the next

page.

After you have selected your export settings, select File and click Run.

Note: A warning message is displayed if you are missing information required to run the export.
Update the settings for the required options, and run the export again.

Review the progress of the export.

You can view the progress of an export through the RDC. Select the following tabs to display specific

information:

= Summary - displays general information about the number of records, processing warnings,
and errors. The following screen shot displays file progress for an export job.
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ltem ‘AZIPPER_DO0VETE file 717 fced-fdfd-4430-a657-892e1b036ack’ processed. [line 162]

&3 of 371 processed

Summary | Errors | Progress | Wamings | Report |

Start Time: 3:26:58 BEM
Curation: 00:00:11

Time Left to Completion: 00:00:54

Total Records: 371

Totzl Processed: &3

Totel Processed w/Warnings: 0O
Totzl Processed w/Errors: O

Average f£ile transfer rate: 478.71 EB/sec
Current bkatch size: 1,000

Metadata: - Files: Direct - SQL Insert Mode: Bulk

= Errors - lists any errors encountered during the load. The Errors tab displays any errors that
occur when you export content with the RDC.

= Progress - displays a detailed view of the load progress.
= Warnings - displays information about loading or connection issues.

= Report - includes the following files that you can export:
o Export Error Report - exports a .csv file with a summary of errors.

o Export Error File - exports a .dat file, which is a document-level load file containing only
records with errors.
= File Transfer Mode - displays the following information:
o Web mode - this mode uses the web server and it is the standard.
o Direct mode - this mode provides faster performance, but requires a connection to the

network hosting the data, as well as specific Windows group permissions. For more
information, see Direct mode on page 13.

9. (Optional) To save your export settings for reuse, point to the File menu, and click Save Export Set-
tings. Choose a location for the export settings file (.kwx).

4.4.3 Fields on the Destination Files tab

The Destination Files tab contains the following sections with their respective fields:
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= Export Location - select a target directory for exporting folders, searches, and production sets. Click

—I to browse for a location. Select Overwrite Files to overwrite any existing files of the same name
in the target export directory.

= Physical File Export - select the Copy Files From Repository option. This is the default option and
copies files from the file server to the specified export location. If you don't select Copy Files From
Repository, Relativity doesn't copy the files to the export location. Instead, the exported load files ref-
erence the repository location of the files.

= Volume Information - controls the naming and size of the volume identifier. Set the following options
in this section:

o

o

Prefix - enter the alpha prefix for the volume identifier.

Start # - select the first number used for the numeric section of the volume identifier. Multiple
volumes increment numbers during export creating unique volume identifiers.

# of Digits - select the number of digits attached to the prefix. (For example, if you select 3, the
output is VOL001, VOL002, and so on.)

Max size - select the maximum size allowed for each volume in MBs.

= Subdirectory Information - controls the naming and size of volume subfolders. Set the following
options in this section:

o

o

o

Image Prefix - enter the alpha prefix for the subdirectory that stores exported images.

Native Prefix - enter the alpha prefix for the subdirectory that stores exported native files.
Text Prefix - enter the alpha prefix for the subdirectory that stores exported extracted text files.
Pdf Prefix - enter the alpha prefix for the subdirectory that stores exported extracted PDF files.
Start # - select the starting number for the subdirectories.

# of Digits - select the number of digits of the subdirectory prefix (For example, if you select 3,
the output is IMG001, IMG002, and so on.)

Max Files - select the number of files to store in each subdirectory.

= File Path - controls how the export path for the files is referenced. Select one of the following options:

[e]

[0}

o

Use absolute paths - paths to exported files are represented as absolute paths.
C:\ Desktop\VOLOO1\NATIVEOO1\AS000001.msg

Use relative paths - paths to exported files are represented as relative paths.
AVOLOO1\NATIVEOO1\AS000001.msg

Use prefix - a prefix is added to the relative path, such as a CD drive letter.
D:\VOLOO1\NATIVEOO1\AS000001.msg

® | oad File Characters - select the delimiters to use in a document-level load file when Data File
Format in the Metadata section is set to Custom. Select the following options as necessary:

o

o

Column - this delimiter separates columns in the load file.

Quote - this delimiter qualifies the text in each field of the load file.
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o Newline - this delimiter signifies the end of any extracted text or long text field in the load file.
° Multi-Value - this delimiter separates different choices within a choice field.

o Nested Value - this delimiter indicates the hierarchy of choices within a choice field.

= Text and Native File Names - select the following options for naming exported native and extracted
text files:

Note: The following field types are supported by this feature: Date, Decimal, Fixed-Length Text,
Single Choice, Whole Number, and Yes/No.

= (Available Only for Production Sets) Named after - select one of the following naming convention for
exported files:

o ldentifier - select this option to name the files after the identifier for your workspace.

° Beginning production number - select this option to name the files after the production num-
ber. (This number may be the Bates number for a production.)

° Custom - select this option to name the native and text files in an export by appending them
with either a control number or production begin bates and optionally, a field of your choice.
To select custom naming options for your exported native and text files, do the following:

o Select Custom from the Named after drop-down menu.

CIickII] to the right of the Named after drop-down menu.

° Select either the control number or production begin bates naming option from the drop-
down menu.

o -

Optionally, to append a field or custom text to the file name, click .
o Select the desired spacing option from the _ (underscore) drop-down menu.

° To either add custom text to the name or to add a field to the name, do the following:
¢ Toinclude custom text as part of the name, choose the Custom Text... option in
the drop-down menu and enter the desired custom text in the textbox underneath
the Custom Text... drop-down menu.

* Toinclude afield as part of the file names, select the desired field option from the
Custom Text... drop-down menu. If a field is empty in a workspace it will not dis-
play as part of the file name even if selected from the Custom Text... drop-down
menu.

Note: If a boolean field is selected, the name of the field will be displayed and
not the value. For example: JWOLFE_009 confidential-HAS IMAGES.

° Optionally, to add an additional field or custom text after the previously selected options,
+
click —l

o Select the desired spacing option from the _ (underscore) drop-down menu.
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° To either add additional custom text to the name or to add an additional field to the
name, do the following:

¢ Toinclude additional custom text as part of the name before a field, choose the
Custom Text... option in the drop-down menu and enter the desired custom text
in the textbox underneath the Custom Text... drop-down menu.

¢ Toinclude an additional field as part of the name, select the desired field option
from the Custom Text... drop-down menu. If a field is empty in a workspace it will
not display as part of the file name even if selected from the Custom Text... drop-
down menu.

Note: If a boolean field is selected, the name of the field will be displayed and
not the value. For example: JWOLFE_009_confidential-HAS IMAGES.

° Click Apply to save the current naming options.

Note: If a file is not found in any of the production sets, the name will revert to the
control number or production begin bates regardless of which naming options you
have selected.

= Append original file - Select this option to append the original file name which is defined as the file
name as it was on disk to the end of the exported file name.

= |mage - determines whether to include images in an export and sets the format of the load file. Set
the following options:

o Check Export Images - select this option to include images in the export. (You must set the
Data File Format and the File Type when you exportimages.)

o Data File Format - select one of these formats for image-level load file:
e Opticon

e |IPRO

° File Type - select one of these file types:
¢ Single-page TIF/JPG

¢ Multi-page TIF
 PDF
= Native - controls which files are exported by Relativity Desktop Client.
o Export Native Files - select to export native files.

o Export rendered PDF's - select to export PDF files. This option is not available when export-
ing a Production set.

= Metadata - use the following options to control the export of the document-level load file and extrac-
ted text:

Desktop Client Guide



[e]

Data File Format - select a the format for the document-level load file you're exporting:

¢ Comma separated (.csv)

¢ Concordance (.dat) - load file exports with the standard Concordance delimiters.

¢ Custom (.txt) - load file exports with the custom delimiters that you select in the Load
File Characters section.

e HTML (.html) - load file is in HTML and contains hyperlinks to launch any exported files.

o

Data File Encoding - select an encoding for the document-level load file from the drop-down

box. Click L] for additional options.

o

Export Text Field as Files - determines the export of the extracted text or OCR. Select this

option if you want to export files as individual document-level text files, with one file per doc-
ument. The RDC includes text as part of your load file if you deselect this option.

° Text File Encoding - select the encoding for the document-level text files. ClickEI for addi-

tional options.

o

Text Precedence - select and assign an order to long text fields that Relativity checks for text

when performing an export. You must select one or more long text fields to use this func-

tionality. CIickEl to display the Pick Text Precedence pop-up. To move fields between
columns, highlight them and click the Right or Left single or double arrows. Use the Up and
Down arrows to order the precedence of the fields.

-
|‘_E,-| Pick Text Precedence

HAorailable Long Text Fields

BCC

CC

Comments
Conversation |Ds
Source File

To

S5
Selected Long Text Fields
OCR Text
Extracted Text
>3
—_ l|
= b
«€ L
[
Ok | f
N
Cancel J

If you add any fields to the Selected Long Text Fields column, Relativity adds the Text
Precedence column as the last column in the load file. During an export, Relativity checks the
topmost field in the Selected Long Text Fields column for text, and if the field is null, it checks
the next field in order of precedence for text. When it finds a field that contains text, Relativity
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adds the contents of that field to the Text Precedence column in the document load file, and
then continues checking the fields for the next document.

For example, you want the Text Precedence column in the load file to contain the contents of
the OCR Text field when it is available for a document and the contents of the Extracted Text
field when the OCR Text for a document is null. In the Pick Text Precedence pop-up, you add
the OCR Text as the first field in the Selected Long Text Fields column followed by the
Extracted Text field.

Note: If you want to improve export performance, you don't need to add all of the long text
fields you select in the Pick Text Precedence pop-up to the Selected Columns option on the
Data Source tab. When you don't select these fields on the Data Source tab, but you add
them to Selected Long Text Fields column, the RDC adds the content of these fields to the
Text Precedence column as described above. When you add the long text fields on the Data
Source tab, Relativity adds these columns to the document level load file.

The Precedence Text column displays the file path to the exported files if you select the Export
Text Field as Files checkbox.

o Export Multiple-Choice Fields as Nested - select this option to maintain the hierarchy of
Relativity multiple-choice lists, when applicable. The nested value delimiter, a backslash, sep-
arates child choices.

4.5 Exporting a folder

You can export the contents of a specific workspace folder through the RDC.

Note: To preserve the current folder structure of each document in a long text field, you have the option of
running the Set Relativity folder path field script when you're exporting a folder through the RDC.

4.5.1 Exporting RDC Permissions

The following permissions are required to use the exporting feature in Relativity Desktop Client:

Object Security Adml_n Oper-
ations
® Document: Local Access (Download, Copy Text)
Note: This is required when exporting long-text cells greater than the value defined by the = Allow
MaximumLongTextSizeForExportinCell instance setting, the default value of which is Export
1048576.

4.5.2 Exporting a folder

Note: When you select the Folder option, only the contents of the current folder are exported. Use
Folder and Subfolders option to export the contents of both the folder and its subfolders, or the contents
of an entire workspace. See Exporting a folder and its subfolders on page 86.

To export a folder:
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1. Open the RDC and then select a workspace.
2. Inthe RDC browser, right-click on a specific folder, point to Export and then click Folder.

You can also highlight a folder in the RDC browser. On the Tools menu, point to Export and click
Folder.) The Data Source tab in the Export Production window appears.

3. (Optional) To use settings in an existing export file, complete these steps:
a. Click theFile menu, and select Load Export Settings.

b. Browse for your export settings file (.kwx) in the Open dialog.

c. Selecta view, and click OK. Your view is listed on the Data Source tab, and determines the
fields displayed in the Selected Columns box. Other settings from the file are used to pop-
ulate the Destination Files tab. (You can also modify any settings on the Data Source and
Destination Files tab as necessary.)

Note: On the Destination Files tab, you may want to select Overwrite Files if you are re-
exporting the same group of files to the previously used location.

TRelathty Deskiop ¢

Mame

Domains
OCR Documents

Responsiveness View 2

0K

d. Continue with step 7.

1. Onthe Data Source tab, select a view in the Views box. Update the remaining options as necessary.
The Data Source tab appears when you select the option to export production sets, saved searches,
folders, and subfolders. You will see similar options on the tab for each of these actions, but you may
want to select different settings for them. The following screen shot uses a production set as an
example, but the settings are the same when exporting production sets, saved searches, folders, and
subfolders.
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On the Data Source tab, you can set the following options for the data that you want to export.
Depending on the type of data you want to export, the dropdown updates accordingly. Select from the

following:

= Views - Folders and subfolders - select a view for the data that you want to export.

Searches - Saved Search - select a saved search you want to export.

Productions - Production set - select a production set you want to export

Selected Columns - choose the fields that you want to export by moving them to the Selected
Columns box. The box on the right displays all available fields. Only the fields in the Selected
Columns box are exported.

Note: If a reflected production field is selected for Selected Column, the RDC doesn't narrow
down the field to a specific production. The reflected field for all productions is included.

Start Export at Record # - select a record number that identifies the initial document for
export. The RDC exports the document with this record number and continues exporting doc-
uments with subsequent record numbers.

(Available only for Saved Searches, Folders, and Subfolders) Production Precedence - click

L] to display the Pick Production Precedence dialog where you can select a group of pro-
duced documents for export instead of the original images.
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o Select the images that you want to export:
¢ Original Images - export only the original, non-produced images.

¢ Produced Images - export a produced version of the images.

¢ Include original images... - export original images for the documents that are
not in a specified production.

° Move the productions that you want to exported to the Selected Productions box. To
move productions between columns, highlight the production and click the Right or Left
single or double arrows. Use the Up and Down arrows to order the precedence of the
fields.

Note: Any produced native files will be exported as a native instead of an image. Only
one produced image is exported based on precedence in the list. If the document is in
the topmost production, that version is exported. If not, Relativity checks for the
document in the second production and so on. If the document is not a part of any of
the selected productions, and Include original images ... is enabled, then the
original document is produced.

4. Select the Destination Files tab.
On the Destination tab, you can set options that control how the files in folders, searches, and
production sets are exported. The Export dialog displays this tab when you select an Export option
from the Tools menu, or when you right-click on a folder or workspace in the RDC. The Destination
tab displays the same options when you export files in folders, searches, or production sets.
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@ Relativity Desktop Client | Export Saved Search

— O *
— Text and Native File Names
MNamed after: | Select... LI |
[~ Append original filename
—Image
¥ Export Images
Data File Format: | Select... |
File Type: | Select... |
—Native
¥ Export Native Files ¥ Export rendered PDF's
—Metadata
Data File Format: | Select... =l
Data File Encoding: | Select... =l | 2]
[~ Export Text Field as Files
Text File Encoding: | Select... =
Text Preoedenoe:l |

[¥ Export Multiple Choice Fields as Nested

File
Dats Source Destnation s | <
— Export Location
[Select a folder ... |
[~ Overwrite Files
—Physical File Export —File Path
¥ Copy Files From Repository (¥ |Use Relative Paths
—\olume Information " Use Absolute Paths
Prefis: IVOL " Use Prefix I
Start#:|1 3: #ofdigits:IE 3:
Max Size (MB): m&n : —Load File Characters
Column: IJ (ASCII:020) vl
—Subdirectory Information
Image Preﬁx:IIMG QUD’EB:IIJ (ASCII:254) vl
Native Prefix: [NATIVE Newline® (ASCIN72) <]
Text Prefix: ITEXT
Multi—VaIue:I: (ASCII:059) vl
PdfPrefic: [PDF
Nested Value: I \ (ASCII:092) vl
Start #: |1 3: #ofdigits:|3 3: } :
Max Files:[500 =

Note: In the Text and Native File Name section, the Named after option is available only for

Production Sets.

Complete the fields on the Destination Files tab. See Fields on the Destination Files tab on the next

page.

After you have selected your export settings, select File and click Run.

Note: A warning message appears if you are missing information required to run the export.
Update the settings for the required options, and run the export again.

Review the progress of the export.

You can view the progress of an export through the RDC. Select the following tabs to display specific

information:

= Summary - displays general information about the number of records, processing warnings,
and errors. The following screen shot displays file progress for an export job.
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ltem ‘AZIPPER_DO0VETE file 717 fced-fdfd-4430-a657-892e1b036ack’ processed. [line 162]

&3 of 371 processed

Summary | Errors | Progress | Wamings | Report |

Start Time: 3:26:58 BEM
Curation: 00:00:11

Time Left to Completion: 00:00:54

Total Records: 371

Totzl Processed: &3

Totel Processed w/Warnings: 0O
Totzl Processed w/Errors: O

Average f£ile transfer rate: 478.71 EB/sec
Current bkatch size: 1,000

Metadata: - Files: Direct - SQL Insert Mode: Bulk

= Errors - lists any errors encountered during the load. The Errors tab displays any errors that
occur when you export content with the RDC.

= Progress - displays a detailed view of the load progress.
= Warnings - displays information about loading or connection issues.

= Report - includes the following files that you can export:
o Export Error Report - exports a .csv file with a summary of errors.

o Export Error File - exports a .dat file, which is a document-level load file containing only
records with errors.
= File Transfer Mode - displays the following information:
o Web mode - this mode uses the web server and it is the standard.
o Direct mode - this mode provides faster performance, but requires a connection to the

network hosting the data, as well as specific Windows group permissions. For more
information, see Direct mode on page 13.

8. (Optional) To save your export settings, point to the File menu, and click Save Export Settings.
Choose a location for the export settings file (.kwx).

4.5.3 Fields on the Destination Files tab

The Destination Files tab contains the following sections with their respective fields:
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= Export Location - select a target directory for exporting folders, searches, and production sets. Click

—I to browse for a location. Select Overwrite Files to overwrite any existing files of the same name
in the target export directory.

= Physical File Export - select the Copy Files From Repository option. This is the default option and
copies files from the file server to the specified export location. If you don't select Copy Files From
Repository, Relativity doesn't copy the files to the export location. Instead, the exported load files ref-
erence the repository location of the files.

= Volume Information - controls the naming and size of the volume identifier. Set the following options
in this section:

o

o

Prefix - enter the alpha prefix for the volume identifier.

Start # - select the first number used for the numeric section of the volume identifier. Multiple
volumes increment numbers during export creating unique volume identifiers.

# of Digits - select the number of digits attached to the prefix. (For example, if you select 3, the
output is VOL001, VOL002, and so on.)

Max size - select the maximum size allowed for each volume in MBs.

= Subdirectory Information - controls the naming and size of volume subfolders. Set the following
options in this section:

o

o

o

Image Prefix - enter the alpha prefix for the subdirectory that stores exported images.

Native Prefix - enter the alpha prefix for the subdirectory that stores exported native files.
Text Prefix - enter the alpha prefix for the subdirectory that stores exported extracted text files.
Pdf Prefix - enter the alpha prefix for the subdirectory that stores exported extracted PDF files.
Start # - select the starting number for the subdirectories.

# of Digits - select the number of digits of the subdirectory prefix (For example, if you select 3,
the output is IMG001, IMG002, and so on.)

Max Files - select the number of files to store in each subdirectory.

= File Path - controls how the export path for the files is referenced. Select one of the following options:

[e]

[0}

o

Use absolute paths - paths to exported files are represented as absolute paths.
C:\ Desktop\VOLOO1\NATIVEOO1\AS000001.msg

Use relative paths - paths to exported files are represented as relative paths.
AVOLOO1\NATIVEOO1\AS000001.msg

Use prefix - a prefix is added to the relative path, such as a CD drive letter.
D:\VOLOO1\NATIVEOO1\AS000001.msg

® | oad File Characters - select the delimiters to use in a document-level load file when Data File
Format in the Metadata section is set to Custom. Select the following options as necessary:

o

o

Column - this delimiter separates columns in the load file.

Quote - this delimiter qualifies the text in each field of the load file.
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o Newline - this delimiter signifies the end of any extracted text or long text field in the load file.
° Multi-Value - this delimiter separates different choices within a choice field.

o Nested Value - this delimiter indicates the hierarchy of choices within a choice field.

= Text and Native File Names - select the following options for naming exported native and extracted
text files:

Note: The following field types are supported by this feature: Date, Decimal, Fixed-Length Text,
Single Choice, Whole Number, and Yes/No.

= (Available Only for Production Sets) Named after - select one of the following naming convention for
exported files:

o ldentifier - select this option to name the files after the identifier for your workspace.

° Beginning production number - select this option to name the files after the production num-
ber. (This number may be the Bates number for a production.)

° Custom - select this option to name the native and text files in an export by appending them
with either a control number or production begin bates and optionally, a field of your choice.
To select custom naming options for your exported native and text files, do the following:

o Select Custom from the Named after drop-down menu.

CIickII] to the right of the Named after drop-down menu.

° Select either the control number or production begin bates naming option from the drop-
down menu.

o -

Optionally, to append a field or custom text to the file name, click .
o Select the desired spacing option from the _ (underscore) drop-down menu.

° To either add custom text to the name or to add a field to the name, do the following:
¢ Toinclude custom text as part of the name, choose the Custom Text... option in
the drop-down menu and enter the desired custom text in the textbox underneath
the Custom Text... drop-down menu.

* Toinclude afield as part of the file names, select the desired field option from the
Custom Text... drop-down menu. If a field is empty in a workspace it will not dis-
play as part of the file name even if selected from the Custom Text... drop-down
menu.

Note: If a boolean field is selected, the name of the field will be displayed and
not the value. For example: JWOLFE_009 confidential-HAS IMAGES.

° Optionally, to add an additional field or custom text after the previously selected options,
+
click —l

o Select the desired spacing option from the _ (underscore) drop-down menu.
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° To either add additional custom text to the name or to add an additional field to the
name, do the following:

¢ Toinclude additional custom text as part of the name before a field, choose the
Custom Text... option in the drop-down menu and enter the desired custom text
in the textbox underneath the Custom Text... drop-down menu.

¢ Toinclude an additional field as part of the name, select the desired field option
from the Custom Text... drop-down menu. If a field is empty in a workspace it will
not display as part of the file name even if selected from the Custom Text... drop-
down menu.

Note: If a boolean field is selected, the name of the field will be displayed and
not the value. For example: JWOLFE_009_confidential-HAS IMAGES.

° Click Apply to save the current naming options.

Note: If a file is not found in any of the production sets, the name will revert to the
control number or production begin bates regardless of which naming options you
have selected.

= Append original file - Select this option to append the original file name which is defined as the file
name as it was on disk to the end of the exported file name.

= |mage - determines whether to include images in an export and sets the format of the load file. Set
the following options:

o Check Export Images - select this option to include images in the export. (You must set the
Data File Format and the File Type when you exportimages.)

o Data File Format - select one of these formats for image-level load file:
e Opticon

e |IPRO

° File Type - select one of these file types:
¢ Single-page TIF/JPG

¢ Multi-page TIF
 PDF
= Native - controls which files are exported by Relativity Desktop Client.
o Export Native Files - select to export native files.

o Export rendered PDF's - select to export PDF files. This option is not available when export-
ing a Production set.

= Metadata - use the following options to control the export of the document-level load file and extrac-
ted text:
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[e]

Data File Format - select a the format for the document-level load file you're exporting:

¢ Comma separated (.csv)

¢ Concordance (.dat) - load file exports with the standard Concordance delimiters.

¢ Custom (.txt) - load file exports with the custom delimiters that you select in the Load
File Characters section.

e HTML (.html) - load file is in HTML and contains hyperlinks to launch any exported files.

o

Data File Encoding - select an encoding for the document-level load file from the drop-down

box. Click L] for additional options.

o

Export Text Field as Files - determines the export of the extracted text or OCR. Select this

option if you want to export files as individual document-level text files, with one file per doc-
ument. The RDC includes text as part of your load file if you deselect this option.

° Text File Encoding - select the encoding for the document-level text files. ClickEI for addi-

tional options.

o

Text Precedence - select and assign an order to long text fields that Relativity checks for text

when performing an export. You must select one or more long text fields to use this func-

tionality. CIickEl to display the Pick Text Precedence pop-up. To move fields between
columns, highlight them and click the Right or Left single or double arrows. Use the Up and
Down arrows to order the precedence of the fields.

-
|‘_E,-| Pick Text Precedence

HAorailable Long Text Fields

BCC

CC

Comments
Conversation |Ds
Source File

To

S5
Selected Long Text Fields
OCR Text
Extracted Text
>3
—_ l|
= b
«€ L
[
Ok | f
N
Cancel J

If you add any fields to the Selected Long Text Fields column, Relativity adds the Text
Precedence column as the last column in the load file. During an export, Relativity checks the
topmost field in the Selected Long Text Fields column for text, and if the field is null, it checks
the next field in order of precedence for text. When it finds a field that contains text, Relativity
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adds the contents of that field to the Text Precedence column in the document load file, and
then continues checking the fields for the next document.

For example, you want the Text Precedence column in the load file to contain the contents of
the OCR Text field when it is available for a document and the contents of the Extracted Text
field when the OCR Text for a document is null. In the Pick Text Precedence pop-up, you add
the OCR Text as the first field in the Selected Long Text Fields column followed by the
Extracted Text field.

Note: If you want to improve export performance, you don't need to add all of the long text
fields you select in the Pick Text Precedence pop-up to the Selected Columns option on the
Data Source tab. When you don't select these fields on the Data Source tab, but you add
them to Selected Long Text Fields column, the RDC adds the content of these fields to the
Text Precedence column as described above. When you add the long text fields on the Data
Source tab, Relativity adds these columns to the document level load file.

The Precedence Text column displays the file path to the exported files if you select the Export
Text Field as Files checkbox.

o Export Multiple-Choice Fields as Nested - select this option to maintain the hierarchy of
Relativity multiple-choice lists, when applicable. The nested value delimiter, a backslash, sep-
arates child choices.

4.6 Exporting a folder and its subfolders

You can export the contents of a folder and its subfolders, as well as an entire workspace, through the RDC.

Note: To preserve the current folder structure of each document in a long text field, you have the option of
running the Set Relativity folder path field script when you're exporting a folder through the RDC.

4.6.1 Exporting RDC Permissions

The following permissions are required to use the exporting feature in Relativity Desktop Client:

Object Security Adml_n Oper-
ations
® Document: Local Access (Download, Copy Text)
Note: This is required when exporting long-text cells greater than the value defined by the = Allow
MaximumLongTextSizeForExportinCell instance setting, the default value of which is Export
1048576.

4.6.2 Exporting a folder and its subfolders

Note: You can also export only the content of the current folder using the Folder option. See Exporting a
folder on page 76.

To export a folder and its subfolders:
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1. Open the RDC and select a workspace.

2. Inthe RDC browser, right-click on a specific folder, point to Export and then click Folder and Sub-
folders.

You can also highlight a folder in the RDC browser. On the Tools menu, point to Export and click
Folder and Subfolders.

The Data Source tab in the Export Production window appears.

Note: To export an entire workspace, highlight the root folder.

3. (Optional) To use settings in an existing export file, complete these steps:
a. Click File and select Load Export Settings.

b. Browse for your export settings file (.kwx) in the Open dialog.

c. Select aview, and then click OK. Your view is lists on the Data Source tab. This determines the
fields listed in the Selected Columns box. Other settings from the file are used to populate the
Destination Files tab. You can also modify any settings on the Data Source and Destination
Files tab as necessary.

Note: On the Destination Files tab, you may want to select Overwrite Files if you are re-
exporting the same group of files to the previously used location.

MName

Domains
QOCR Documents

Fesponsiveness View 2

0K

d. Continue with step 7.

4. Onthe Data Source, select a view in the Views box. Update the remaining options as necessary.
The Data Source tab appears when you select the option to export production sets, saved searches,
folders, and subfolders. You will see similar options on the tab for each of these actions, but you may
want to select different settings for them. The following screen shot uses a production set as an
example, but the settings are the same when exporting production sets, saved searches, folders, and
subfolders.
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On the Data Source tab, you can set the following options for the data that you want to export.
Depending on the type of data you want to export, the dropdown updates accordingly. Select from the

following:

= Views - Folders and subfolders - select a view for the data that you want to export.

Searches - Saved Search - select a saved search you want to export.

Productions - Production set - select a production set you want to export

Selected Columns - choose the fields that you want to export by moving them to the Selected
Columns box. The box on the right displays all available fields. Only the fields in the Selected
Columns box are exported.

Note: If a reflected production field is selected for Selected Column, the RDC doesn't narrow
down the field to a specific production. The reflected field for all productions is included.

Start Export at Record # - select a record number that identifies the initial document for
export. The RDC exports the document with this record number and continues exporting doc-
uments with subsequent record numbers.

(Available only for Saved Searches, Folders, and Subfolders) Production Precedence - click

L] to display the Pick Production Precedence dialog where you can select a group of pro-
duced documents for export instead of the original images.
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o Select the images that you want to export:
¢ Original Images - export only the original, non-produced images.

¢ Produced Images - export a produced version of the images.

¢ Include original images... - export original images for the documents that are
not in a specified production.

° Move the productions that you want to exported to the Selected Productions box. To
move productions between columns, highlight the production and click the Right or Left
single or double arrows. Use the Up and Down arrows to order the precedence of the
fields.

Note: Any produced native files will be exported as a native instead of an image. Only
one produced image is exported based on precedence in the list. If the document is in
the topmost production, that version is exported. If not, Relativity checks for the
document in the second production and so on. If the document is not a part of any of
the selected productions, and Include original images ... is enabled, then the
original document is produced.

5. Select the Destination Files tab.
On the Destination tab, you can set options that control how the files in folders, searches, and
production sets are exported. The Export dialog displays this tab when you select an Export option
from the Tools menu, or when you right-click on a folder or workspace in the RDC. The Destination
tab displays the same options when you export files in folders, searches, or production sets.
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@ Relativity Desktop Client | Export Saved Search

— O *
— Text and Native File Names
MNamed after: | Select... LI |
[~ Append original filename
—Image
¥ Export Images
Data File Format: | Select... |
File Type: | Select... |
—Native
¥ Export Native Files ¥ Export rendered PDF's
—Metadata
Data File Format: | Select... =l
Data File Encoding: | Select... =l | 2]
[~ Export Text Field as Files
Text File Encoding: | Select... =
Text Preoedenoe:l |

[¥ Export Multiple Choice Fields as Nested

File
Dats Source Destnation s | <
— Export Location
[Select a folder ... |
[~ Overwrite Files
—Physical File Export —File Path
¥ Copy Files From Repository (¥ |Use Relative Paths
—\olume Information " Use Absolute Paths
Prefis: IVOL " Use Prefix I
Start#:|1 3: #ofdigits:IE 3:
Max Size (MB): m&n : —Load File Characters
Column: IJ (ASCII:020) vl
—Subdirectory Information
Image Preﬁx:IIMG QUD’EB:IIJ (ASCII:254) vl
Native Prefix: [NATIVE Newline® (ASCIN72) <]
Text Prefix: ITEXT
Multi—VaIue:I: (ASCII:059) vl
PdfPrefic: [PDF
Nested Value: I \ (ASCII:092) vl
Start #: |1 3: #ofdigits:|3 3: } :
Max Files:[500 =

Note: In the Text and Native File Name section, the Named after option is available only for

Production Sets.

Complete the fields on the Destination Files tab. See Fields on the Destination Files tab on the next

page.

After you have selected your export settings, select File and then click Run.

Note: A warning message displays if you are missing information required to run the export.
Update the settings for the required options, and run the export again.

Review the progress of the export.

You can view the progress of an export through the RDC. Select the following tabs to display specific

information:

= Summary - displays general information about the number of records, processing warnings,
and errors. The following screen shot displays file progress for an export job.
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Y Export Saved Search Progress .. -

161
ltem ‘AZIPPER_DO0VETE file 717 fced-fdfd-4430-a657-892e1b036ack’ processed. [line 162]

&3 of 371 processed

Summary | Errors | Progress | Wamings | Report |

Start Time: 3:26:58 BEM
Curation: 00:00:11

Time Left to Completion: 00:00:54

Total Records: 371

Totzl Processed: &3

Totel Processed w/Warnings: 0O
Totzl Processed w/Errors: O

Average f£ile transfer rate: 478.71 EB/sec
Current bkatch size: 1,000

Metadata: - Files: Direct - SQL Insert Mode: Bulk

= Errors - lists any errors encountered during the load. The Errors tab displays any errors that
occur when you export content with the RDC.

= Progress - displays a detailed view of the load progress.
= Warnings - displays information about loading or connection issues.

= Report - includes the following files that you can export:
o Export Error Report - exports a .csv file with a summary of errors.

o Export Error File - exports a .dat file, which is a document-level load file containing only
records with errors.
= File Transfer Mode - displays the following information:
o Web mode - this mode uses the web server and it is the standard.
o Direct mode - this mode provides faster performance, but requires a connection to the

network hosting the data, as well as specific Windows group permissions. For more
information, see Direct mode on page 13.

9. (Optional) To save your export settings, click File > Save Export Settings. Choose a location for the
export settings file (.kwx).

4.6.3 Fields on the Destination Files tab

The Destination Files tab contains the following sections with their respective fields:
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= Export Location - select a target directory for exporting folders, searches, and production sets. Click

—I to browse for a location. Select Overwrite Files to overwrite any existing files of the same name
in the target export directory.

= Physical File Export - select the Copy Files From Repository option. This is the default option and
copies files from the file server to the specified export location. If you don't select Copy Files From
Repository, Relativity doesn't copy the files to the export location. Instead, the exported load files
reference the repository location of the files.

= Volume Information - controls the naming and size of the volume identifier. Set the following options
in this section:

[0}

[0}

o

Prefix - enter the alpha prefix for the volume identifier.

Start # - select the first number used for the numeric section of the volume identifier. Multiple
volumes increment numbers during export creating unique volume identifiers.

# of Digits - select the number of digits attached to the prefix. (For example, if you select 3, the
output is VOL001, VOL002, and so on.)

Max size - select the maximum size allowed for each volume in MBs.

= Subdirectory Information - controls the naming and size of volume subfolders. Set the following
options in this section:

o

o

o

o

Image Prefix - enter the alpha prefix for the subdirectory that stores exported images.

Native Prefix - enter the alpha prefix for the subdirectory that stores exported native files.
Text Prefix - enter the alpha prefix for the subdirectory that stores exported extracted text files.
Pdf Prefix - enter the alpha prefix for the subdirectory that stores exported extracted PDF files.
Start # - select the starting number for the subdirectories.

# of Digits - select the number of digits of the subdirectory prefix (For example, if you select 3,
the output is IMGO001, IMG002, and so on.)

Max Files - select the number of files to store in each subdirectory.

= File Path - controls how the export path for the files is referenced. Select one of the following options:

o

o

o

Use absolute paths - paths to exported files are represented as absolute paths.
C:\ Desktop\VOLOO1\NATIVEOO1\AS000001.msg

Use relative paths - paths to exported files are represented as relative paths.
AVOLOON\NATIVEOO1\AS000001.msg

Use prefix - a prefix is added to the relative path, such as a CD drive letter.
D:\VOLOON\NATIVEOO1\AS000001.msg

® | oad File Characters - select the delimiters to use in a document-level load file when Data File
Format in the Metadata section is set to Custom. Select the following options as necessary:

o

o

[0}

Column - this delimiter separates columns in the load file.
Quote - this delimiter qualifies the text in each field of the load file.

Newline - this delimiter signifies the end of any extracted text or long text field in the load file.
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o Multi-Value - this delimiter separates different choices within a choice field.

o Nested Value - this delimiter indicates the hierarchy of choices within a choice field.

= Text and Native File Names - select the following options for naming exported native and extracted

text files:

Note: The following field types are supported by this feature: Date, Decimal, Fixed-Length Text,
Single Choice, Whole Number, and Yes/No.

= (Available Only for Production Sets) Named after - select one of the following naming convention for
exported files:
o ldentifier - select this option to name the files after the identifier for your workspace.

o Beginning production number - select this option to name the files after the production
number. (This number may be the Bates number for a production.)

o Custom - select this option to name the native and text files in an export by appending them
with either a control number or production begin bates and optionally, a field of your choice.
To select custom naming options for your exported native and text files, do the following:

o

Select Custom from the Named after drop-down menu.

ClickIII to the right of the Named after drop-down menu.

Select either the control number or production begin bates naming option from the drop-

down menu.
]

Optionally, to append a field or custom text to the file name, click .
Select the desired spacing option from the _ (underscore) drop-down menu.

To either add custom text to the name or to add a field to the name, do the following:

o Toinclude custom text as part of the name, choose the Custom Text... option in
the drop-down menu and enter the desired custom text in the textbox underneath
the Custom Text... drop-down menu.

o Toinclude a field as part of the file names, select the desired field option from the
Custom Text... drop-down menu. If a field is empty in a workspace it will not
display as part of the file name even if selected from the Custom Text... drop-
down menu.

Note: If a boolean field is selected, the name of the field will be displayed and
not the value. For example: JIWOLFE_009_confidential-HAS IMAGES.

Optionally, to add an additional field or custom text after the previously selected options,

=

click .
Select the desired spacing option from the _ (underscore) drop-down menu.

To either add additional custom text to the name or to add an additional field to the
name, do the following:

¢ Toinclude additional custom text as part of the name before a field, choose the
Custom Text... option in the drop-down menu and enter the desired custom text
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in the textbox underneath the Custom Text... drop-down menu.

o Toinclude an additional field as part of the name, select the desired field option
from the Custom Text... drop-down menu. If a field is empty in a workspace it will
not display as part of the file name even if selected from the Custom Text... drop-
down menu.

Note: If a boolean field is selected, the name of the field will be displayed and
not the value. For example: JWOLFE_009_confidential-HAS IMAGES.

o Click Apply to save the current naming options.

Note: If afile is not found in any of the production sets, the name will revert to the
control number or production begin bates regardless of which naming options you
have selected.

= Append original file - Select this option to append the original file name which is defined as the file
name as it was on disk to the end of the exported file name.

= |mage - determines whether to include images in an export and sets the format of the load file. Set
the following options:

o Check Export Images - select this option to include images in the export. (You must set the
Data File Format and the File Type when you exportimages.)

o Data File Format - select one of these formats for image-level load file:
e Opticon

« IPRO

o File Type - select one of these file types:
» Single-page TIF/JPG

o Multi-page TIF
- PDF
= Native - controls which files are exported by Relativity Desktop Client.
o Export Native Files - select to export native files.

o Export rendered PDF's - select to export PDF files. This option is not available when
exporting a Production set.

= Metadata - use the following options to control the export of the document-level load file and
extracted text:

o Data File Format - select a the format for the document-level load file you're exporting:
o Comma separated (.csv)

o Concordance (.dat) - load file exports with the standard Concordance delimiters.

o Custom (.txt) - load file exports with the custom delimiters that you select in the Load
File Characters section.

o HTML (.html) - load file is in HTML and contains hyperlinks to launch any exported files.

o Data File Encoding - select an encoding for the document-level load file from the drop-down

box. Click ] for additional options.
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o Export Text Field as Files - determines the export of the extracted text or OCR. Select this
option if you want to export files as individual document-level text files, with one file per
document. The RDC includes text as part of your load file if you deselect this option.

Text File Encoding - select the encoding for the document-level text files. ClickEI for
additional options.

o Text Precedence - select and assign an order to long text fields that Relativity checks for text
when performing an export. You must select one or more long text fields to use this

functionality. ClicklzI to display the Pick Text Precedence pop-up. To move fields between
columns, highlight them and click the Right or Left single or double arrows. Use the Up and
Down arrows to order the precedence of the fields.

F N
|‘_E,-| Pick Text Precedence u
HAorailable Long Text Fields Selected Long Text Fields
BCC OCR Text
CC Extracted Text
Comments
Conversation |Ds
Source File
To
>3
| == ll
=
|
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= b
€ I
'l
Ok | f
I i
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If you add any fields to the Selected Long Text Fields column, Relativity adds the Text
Precedence column as the last column in the load file. During an export, Relativity checks the
topmost field in the Selected Long Text Fields column for text, and if the field is null, it checks
the next field in order of precedence for text. When it finds a field that contains text, Relativity
adds the contents of that field to the Text Precedence column in the document load file, and
then continues checking the fields for the next document.

For example, you want the Text Precedence column in the load file to contain the contents of
the OCR Text field when it is available for a document and the contents of the Extracted Text
field when the OCR Text for a document is null. In the Pick Text Precedence pop-up, you add
the OCR Text as the first field in the Selected Long Text Fields column followed by the
Extracted Text field.
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Note: If you want to improve export performance, you don't need to add all of the long text
fields you select in the Pick Text Precedence pop-up to the Selected Columns option on the
Data Source tab. When you don't select these fields on the Data Source tab, but you add
them to Selected Long Text Fields column, the RDC adds the content of these fields to the
Text Precedence column as described above. When you add the long text fields on the Data
Source tab, Relativity adds these columns to the document level load file.

The Precedence Text column displays the file path to the exported files if you select the Export
Text Field as Files checkbox.

o Export Multiple-Choice Fields as Nested - select this option to maintain the hierarchy of
Relativity multiple-choice lists, when applicable. The nested value delimiter, a backslash,
separates child choices.
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5 Configuring the RDC

You can fine-tune the performance of the RDC in your environment by adjusting its configuration settings,
for example, for batching, data validation, and retries.

5.1 RDC configuration

file

You can use the information in this section to update the configuration settings used by the RDC. The Import
API also uses these same settings located in the app.config file.

Use the following instructions to locate the config file on your machine, and set custom configuration

properties for the RDC:

1. Exitthe RDC ifitis currently open.

2. Navigate to the Relativity.Desktop.Client.exe.config file on the machine where the RDC is

installed. By default, this configuration file is located in the following directory:
[Installation_Directory]\kCura Corporation\Relativity Desktop Client

Note: Make a backup copy of this file in case you need to rollback any configuration changes made

toit.

3. Open the Relativity.Desktop.Client.exe.config file in a text or XML editor and modify it as neces-

sary.

5.1.1 Configuration settings

The Relativity.DataExchange section of the Relativity.Desktop.Client.exe.config contains the
configuration properties in the following table.

5.1.1.1 General settings

Name

CreateErrorForlnvalidDate

FileTypeldentifyTimeoutSeconds

HttpExtractedTextTimeoutSeconds

HttpTimeoutSeconds

Description Default Value

When this value is set to True, a zeroed date, such as
0/0/0000, causes an Invalid Date error. When False, True
the date is treated as a NULL value.

Defines the maximum number of seconds to identify a
file type before reaching the timeout.

Defines the timeout, in seconds, for HTTP/REST-
based APl web services specifically used for extrac-
ted text.

10

900

Note: This value doesn't impact WebAPI-based
web services, which means that
WebAPIOperationTimeout setting is still honored.

Defines the timeout, in seconds, for HTTP/REST-

based API web services. 300
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Name

IOErrorNumberOfRetries

IOErrorWaitTimelnSeconds

LogAllEvents

LogConfigFile

TempDirectory

WebAPIOperationTimeout

Description Default Value

Note: This value doesn't impact WebAPI-based
web services, which means the
WebAPIOperationTimeout setting is still honored.

Defines the number of times the RDC retries an
operation within an import or export process afteran 20
IO failure occurs.

Defines the number of seconds the RDC waits before
retrying an operation within an import or export 30
process after an 10 failure occurs.

Enables an option to Save Progress Log when job
completes.

Defines the Relativity Logging configuration file name. LogConfig.xml
When this value is set to True, SSL certificate val-

False

SuppressCertificateCheckOnClient idation errors are suppressed. When False, SSL cer- False

tificate validation errors cause job failures.

Defines a temp directory override where short lived

import files are stored. When not defined, the user pro-

file % TEMP% directory is used.

Defines the time in milliseconds, which an XML Web

service client waits for the reply to a synchronous XML 600000
Web service request to arrive.

5.1.1.2 Transfer settings

Name

BadPathErrorsRetry

PermissionErrorsRetry

TapiAsperaBcpRootFolder

TapiFileNotFoundErrorsDisabled

TapiFileNotFoundErrorsRetry

Description Default Value

When this value is set to True, bad path errors are

retried during a transfer. When False, permission

errors aren't retried and cause job failures.

Note: This setting is a transfer specific setting that True

addresses scenarios where transfer clients (Aspera
in particular) fail to transfer a file because of
intermittent 1/0 errors.

When this value is set to True, permission errors are

retried before and during a transfer. When False, per- True
mission errors aren't retried and cause job failures.

Defines the root folder where the BCP files are

uploaded when using the Aspera transfer client.

Note: This setting should never be changed unless
instructed by RelativityOne support.

When this value is set to True, missing files aren't
treated as errors. When False, missing files are treated False
as errors.

When this value is set to True, missing files are retried. True
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Name

TapiForceAsperaClient

TapiForceBcpHttpClient

TapiForceClientCandidates

TapiForceFileShareClient

TapiForceHttpClient

TapiLargeFileProgressEnabled

TapiMaxInactivitySeconds

TapiMaxJobParallelism

TapiMinDataRateMbps

TapiPreserveFileTimestamps

Description Default Value

When False, missing files aren't retried.

When this value is set to True, the Aspera transfer
client is forced. When False, the best fit transfer client
is chosen at runtime.

When this value is set to True, the HTTP transfer client
is forced only for BCP operations. When false, the best
fit transfer client is chosen at runtime.

False

False
Note: This setting is provided for RelativityOne
client domain environments where the BCP share
isn't accessible from the primary file share.

Forces an ordered list of transfer clients when probing
a workspace and choosing the best client. This value
represents a semi-colon delimited list. Native transfer
client identifiers must be used, such as FileShare,
Aspera, or Http.

When this value is set to True, the file share transfer cli-
ent is forced. When False, the best fit transfer clientis False
chosen at runtime.

When this value is set to True, the HTTP transfer client
is forced. When false, the best fit transfer client is

chosen at runtime. False

Note: This setting is the same as web mode.

When this value is set to True, large-file progress is
used by transfer clients to display "Trip x of y" chunk
info within the status area. When False, no chunk info
is displayed .

The maximum number of seconds that elapse with no
data movement occurring before the transfer is treated
as inactive. When this occurs, the import or export job
continues but performance may be degraded.

Defines the maximum degree of parallelism for a trans-
fer client job. This value isn't guaranteed to be honored 10
by all clients.

Defines the minimum data rate in Mbps units. If set to
zero, the best value is chosen. This value isn't guar-
anteed to be honored by all clients.

False

180

0
Note: This setting is provided for RelativityOne
Aspera transfers.
When this value is set to True, the RDC preserves the
import and export file timestamps. Only direct and False

RelativityOne Aspera modes support this functionality.
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Name

TapiTargetDataRateMbps

TapiTransferLogDirectory

Description Default Value

Note: By default, this value is set to False, because
preserving file timestamps may degrade
performance between 10-20%.

Defines the target data rate in Mbps units. This value
isn't guaranteed to be honored by all clients.

100
Note: This setting is provided for RelativityOne
Aspera transfers.

Defines the directory where Relativity Logging and Y%temp%\RDC_

CreateErrorForinvalidDate

DisablelmagelLocationValidation

DisablelmageTypeValidation

DisableNativelLocationValidation

DisableNativeValidation

transfer client logs are stored. log\
5.1.1.3 Import settings
e Default
Name Description Value
Controls the details collected in an audit:
® FullAudit - includes create, update, and delete mes-
sages. Snapshot is also enabled so all current field val-
ues (Audit Details) are captured for updates. This is
AuditLevel the default setting. FullAudit

= NoSnapshot - Includes create, update, and delete
messages. Snapshot is disabled so current field val-
ues (Audit Details) aren't captured for updates.

= NoAudit - Auditing is disabled.

When this value is set to True, a zeroed date, such as
0/0/0000, causes an Invalid Date error. When False, the date True
is treated as a NULL value.

Disables the validation of the image file locations for all jobs
when set to True. See Additional guidelines for disabling file  False
validation on the next page.

Disables the validation of image file types for all jobs when
set to True. Image type validation is dependent upon image
location validation. See Additional guidelines for disabling file
validation on the next page.

False

Disables the validation of the native file locations for all jobs
when set to True. See Additional guidelines for disabling file
validation on the next page.

False

Note: Don't use the DisableNativeLocationValidation flag
when copying files to a repository. File locations are
validated regardless of the flag before they are copied.

Disable the validation of native file types for all jobs. Native

type validation is dependent upon native location validation. False

tHRelativity
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Name

DynamicBatchResizingOn

ImportBatchMaxVolume
ImportBatchSize

JobCompleteBatchSize

MinimumBatchSize

Default

Description Value
See

When this value is set to True, the batch size is automatically
decreased by 100 when a large import job is in progress, and True
it causes a timeout.

Defines the maximum number of bytes before the metadata

is imported. 10485760
Defines the maximum r.1umber of documents or objects 1000
before the metadata is imported.

Defines the file count threshold at which the RDC completes 50000

and recreates the transfer job used to transfer files.

When AutoBatch is set to True, this value represents the

lower bound on the batch size. Batch sizes can't be smaller 100
than this value.

Additional guidelines for disabling file validation
You can disable file validation by setting these configuration settings to true:

DisablelImagelLocationValidation

= DisablelmageTypeValidation

®m DisableNativeLocationValidatio

® DisableNativeValidation

Review the following guidelines before disabling file validation:

= When you disable file type validation, you do not receive any warnings regarding unsupported file
types. It's therefore possible for files to be imaged and result in errors.

= Disabling the file type validation also causes the application to set the Relativity Native Types field to

Unknown Format.

o Setting a native type to unknown has no effect on productions or OCR.

o Setting a native type to unknown has no effect on how the viewer or imaging engine handles
the file. This means that a native type of unknown can't be the sole cause of an error in the
viewer or the imaging engine. If a file is designated unknown and it actually has an unsup-
ported file type, the Viewer or imaging engine throws an error based on the fact that it has an
unsupported file type.

5.1.1.4 Export settings

Name

ExportBatchSize

ExportErrorNumberOfRetries

Default
Value

Defines the maximum number of export documents per batch. 1000

Defines the number of times the RDC retries an operation within
an export process after a non-lO failure. This value should be 20
greater than or equal to the IOErrorNumberOfRetries value.

Description
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Default

Name Description Value

Defines the number of seconds the RDC waits before retrying an
operation within an export process after a non-IO failure. This
value should be greater than or equal to the
IOErrorWaitTimelnSeconds value.

Defines the number of threads that get created during export.

ExportErrorWaitTimelnSeconds 30

ExportThreadCount Note: This configuration setting is only used when the 2
UseOldExport setting is true.

When this value is set to True, the legacy export method is used.
UseOldExport When False, the new export method is used. The old export False
should only be used when encountering compatibility issues.
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This documentation (“Documentation”) and the software to which it relates (“Software”) belongs to
Relativity ODA LLC and/or Relativity’s third party software vendors. Relativity grants written license
agreements which contain restrictions. All parties accessing the Documentation or Software must: respect
proprietary rights of Relativity and third parties; comply with your organization’s license agreement,
including but not limited to license restrictions on use, copying, modifications, reverse engineering, and
derivative products; and refrain from any misuse or misappropriation of this Documentation or Software in
whole or in part. The Software and Documentation is protected by the Copyright Act of 1976, as amended,
and the Software code is protected by the lllinois Trade Secrets Act. Violations can involve substantial
civil liabilities, exemplary damages, and criminal penalties, including fines and possible imprisonment.

©2024. Relativity ODA LLC. All rights reserved. Relativity® is a registered trademark of Relativity
ODALLC.
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